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0 CE Conformance Statement 
 
IMAGE Information Systems Europe GmbH does not accept liability for the illegal or improper 
use of the described software (see the End User License Agreement).  
 
iQ-LITE 3.1 is a component of the software system iQ-SYSTEM PACS and part of the medical 
device iQ-SYSTEM PACS 1.4 as registered according to 21 CFR 807.92(a)(2) with the FDA 510(k) 
number K062488. 
 
The software is certified as a medical device for image processing, diagnosis, archiving and 
communication according to European Council Directive 93/42/EEC concerning medical devices 
and according to FDA 510(k). Nevertheless, diagnosis can only be made using special high-
resolution displays. 
 
The certification according to 93/42/EEC does not apply when the iQ-LITE software is used not 
for human medicine but for veterinary medicine. When used for veterinary purposes, the CE 
mark applied to the software itself and to its corresponding user documentation is null and void. 
 

 

Copyright © 2003-2018 IMAGE Information Systems Europe GmbH  
All rights reserved.  

 
All patient names used in this document are completely fictitious.  
 
The contents of this document are the property of IMAGE Information Systems Europe GmbH 
and may not be reproduced by any method, electronic or photographic, without the express 
written permission of the copyright holder.  
 
Throughout this document trademark names are used. Rather than put in a trademark symbol 
at every occurrence of the trademark name, we state that we are using the names only in an 
editorial fashion and to the benefit of the trademark owner with no intention of infringing upon 
the trademark.  
 
We assume no responsibility for inaccurate information or descriptions of third-party products.  
 
We are dedicated to improving and enhancing the software of our medical imaging and 
communication system. Consequently, the information in this document is subject to change 
without notice. Current information about product improvements can be found on the iQ-
VIEW/PRO homepage: https://image-systems.biz/en/products/iq-system-pacs/workstation-
software/iq-view.html or the manufacturer homepage https://image-systems.biz/.  
  
Further inquiries can be addressed to: info@image-systems.biz.  
 
Arpad Bischof, MD  
February 2018 
 

https://image-systems.biz/en/products/iq-system-pacs/workstation-software/iq-view.html
https://image-systems.biz/en/products/iq-system-pacs/workstation-software/iq-view.html
https://image-systems.biz/
mailto:info@image-systems.biz
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1 Introduction 
 
1.1 Scope of the document 
 
This document represents the iQ-LITE Instructions for Use for software version 3.1 provided by 
IMAGE Information Systems Europe GmbH. 
 

NOTICE: 
iQ-LITE can be used with a different visual style. The user documentation, however, will only 

reference the default Windows style. All screenshots used in these instructions for use are 
based on the Windows style. When a different visual style was set for the application, the 

documentation does not correspond with the actual appearance of the application. 
 
Disclosure level of this document is PUBLIC (PUB), which means that this document is freely 
available to anyone interested, such as resellers, current end users as well as potential 
customers. Primary color is orange. 
 
Symbols used on product labeling: 
 

 

“Manufacturer”: This symbol indicates the medical device manufacturer. 

  

 

“Consult instructions for use”: This symbol indicates the need of the user to 
consult and read the instructions for use (instructions for use, administration 
guides etc.) to ensure the correct and intended use of the software. 

  

eIFU indicator 

“Electronic Instructions for Use”: This notice is found adjacent to the symbol 
“Consult instructions for use” and indicates that the instructions for use are 
provided in electronic form. 

 
NOTICE  

The provided data was researched with the utmost care. Nevertheless, the author does not 
accept any liability for the correctness, completeness and up-to-date nature of the information 

contained in this document. It is the responsibility of the user or the local administrator to 
verify the details by considering suitable sources. The author expressly disclaims liability for 

any provided information. 
 
 
1.2 Purpose of the software 
 
iQ-LITE is an add-on for iQ-VIEW and iQ-VIEW PRO, but can also be integrated directly into 
burning stations and CD/DVD robots. It functions as DICOM viewer placed onto portable media, 
such as CD, DVD or memory stick and reads imaging studies that also exist on the medium.  
 
Referring and treating physicians and veterinarians with radiological training use iQ-LITE for 
digital reading, viewing and reviewing of diagnostic medical images in order to detect and diag-
nose physiological conditions of humans or animals. The aim is to view medical imaging evidence 
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and reports as a basis for therapy decisions. Other healthcare professionals may use iQ-LITE for 
image viewing without diagnostic intention. Patients are not intended to use the application. 
 

NOTICE: 
When the iQ-LITE software is used not for human medicine but for veterinary medicine, the 
product does not fall under the European Council Directive 93/42/EEC and, therefore, does not 

qualify as a medical device in the EEA. The regulations of the 93/42/EEC do not apply. 
 
As the application runs automatically from the medium on which it is placed (if the system is set 
to allow auto-run options), there is no special knowledge needed concerning the installation of 
the device. For its integration into burning stations and CD/DVD robots, IT/PACS administrators 
should consult the iQ-LITE Administration Guide for the proper procedure. 
 
The following sections give more comprehensive details regarding the purpose of iQ-LITE, 
analyzes the intended patient population and the user groups and gives information about the 
use conditions and contraindications. 
 

IMPORTANT NOTICE AND DISCLAIMER: 
In compliance with U. S. patent law we need to inform the user that the iQ-ROBOT software 

will not be available in the United States of America and countries under the jurisdiction of the 
U.S. patent law. It must neither be sold nor used in any way in those countries. The 

manufacturer of iQ-LITE will not assume any responsibility for the use of iQ-LITE on automatic 
burning devices in the stated geographical area. 

 
 
1.2.1 Intended medical indication 
 
iQ-LITE is an add-on for iQ-VIEW and iQ-VIEW PRO, but can also be used separately for an 
integration into burning stations and CD/DVD robots. The iQ-LITE software application is 
intended to be used for portable diagnostic viewing and reviewing of medical imaging studies for 
practice and hospital use. It is placed onto portable media, such as CD, DVD or memory stick, 
and reads out DICOM data also included on the medium. 
 
As such iQ-LITE replaces film-based reading. On the basis of medical imaging data created at 
various modalities, such as Computed Radiography (CR), Computed Tomography (CT) or Mag-
netic Resonance Imaging (MR), digital information is visualized in order to detect and diagnose 
physiological conditions of humans or animals. The iQ-VIEW/PRO DICOM Conformance State-
ment gives details regarding the supported image types. The software is applicable for images 
of any body part defined in the DICOM standard (with only limited use for dental imaging). Its 
aim is to view medical imaging evidence and reports as a basis for therapy decisions. 
 
The main uses of the iQ-LITE software are: 
 
 To display and process diagnostically relevant DICOM and patient data, incl. the performing 

of measurements in images, e.g. distances, angles, regions of interest. Further processing 
functions include cine mode, series comparison, synchronized browsing, scoutline functions, 
windowing, zooming and panning, flipping, rotating and color remapping. 

 To export non-DICOM image data for clinical reference as still pictures or video file. 
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 To print medical images on paper printers in non-diagnostic quality for clinical reference. 
 To visualize any DICOM header information. 
 
The display and processing of DICOM data is limited to the SOP classes and transfer syntaxes 
stated in the iQ-VIEW/PRO DICOM Conformance Statement. DICOM-incompliant data is not 
supported. 
 
There is no direct patient interaction with the device, therefore there is no possibility that the 
device might lead to fatal fault or injury of a patient. 
 
 
1.2.2 Intended patient population 
 
iQ-LITE is not intended to be used by patients. But the software can be used to display and 
process image and patient data of any patient, regardless of characteristics, such as age, weight, 
gender, nationality, ethnicity or physical/mental state.  
 
However, certain patient specifics, such as gender, age, weight, medication, state, etc., can be 
relevant for making proper diagnostic decisions. Some of these specifics may even be relevant 
for the quality of the image material itself. The application users should be aware of these details, 
consult the patient record and include such information in their evaluation of the image material. 
 
The software device is used for the diagnostic evaluation of medical imaging data of healthy 
clients (e.g. imaging resulting from screenings) as well as of patients with diseases and/or 
injuries. 
 
 
1.2.3 Intended users and user groups 
 
Users of iQ-LITE are always healthcare professionals, typically between 25 and 70 years of age. 
The application is not intended to be used by patients, private end-users and/or laymen. As iQ-
LITE is a software application, user characteristics such as weight or gender are irrelevant. 
Limitations regarding the user’s cultural background are not intended. 
 
iQ-LITE is offered in different languages. The default language is English. The recipient of an iQ-
LITE medium will receive the application in only one language and, therefore, requires skills in 
that particular language in order to use the software application properly. The creator of the iQ-
LITE media is responsible for selecting an appropriate GUI language. The user documentation 
included in the application is in English. User instructions in German are available for download 
at the manufacturer’s website. User instructions in other languages will be provided on request 
only. 
 
iQ-LITE is intended to be used by:  
 
 Physicians and veterinarians with training in medical imaging (for reading, viewing and 

reviewing). 
 Physicians and veterinarians without training in medical imaging (for viewing only). 
 IT administrators (for integration of iQ-LITE in burning stations/robots). 
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The necessary experiences an iQ-LITE user is required to have depend on the user groups using 
the device.  
 
Radiologists and physicians/veterinarians with or without radiological training who use the device 
without diagnostic intent must be trained regarding the institution’s medical and radiological 
workflow and procedures. They require basic computer literacy. 
 
Radiologists and physicians/veterinarians with radiological training who use the device as 
radiological reading or reviewing station for diagnostic purposes additionally need appropriate 
knowledge in diagnostic medical imaging. If necessary, this also includes specific knowledge and 
permissions to diagnostically evaluate particular types of imaging data, such as mammography, 
MR or angiography, and/or to read imaging data of different patient groups, such as children 
diagnostics. 
 
IT administrators responsible for managing the proper integration of the device into a burning 
station or CD/DVD robot: 
 
 Professional knowledge regarding IT, computer and network structures and protocols. 
 Work experience in providing and maintaining the proper use of computers, networks and 

software applications. 
 Training regarding the institution’s medical and radiological workflow and procedures. 
 At least basic knowledge regarding DICOM communication and protocols. 
 
The following user training is required for users of all three software applications: 
 
 Studying of iQ-LITE user documentation (Instructions for Use for users, Administration Guide 

for device and network administrators). 
 iQ-LITE integration training for administrators by an authorized partner of the manufacturer. 
 
The device is not designed barrier-free. It is not intended for visually-impaired users. Other 
physical impairment primarily concerns the ability to reach and handle the computer, on which 
the software is installed, and software in general. Speech input to control the application is not 
implemented. 
 
 
1.2.4 Conditions of use 
 
iQ-LITE is only intended for medical healthcare professionals and only for routine procedures for 
short-term use. It is used temporarily when a referring or treating physician reads, views or 
reviews the DICOM data stored on the portable medium. 
 
The typical location of application for the iQ-LITE software is on computers of referring or treating 
physicians in practices or hospitals. 
 
Where iQ-LITE is used for diagnostic reading and reviewing and for viewing as basis for therapy 
decisions, the workstations must be equipped with diagnostic displays that are regularly re-
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calibrated to ensure consistency in image display. The workstations are positioned in darkened 
rooms to provide suitable environments for image display and processing.  
 
It is possible that the medical device is used in distractive environments. The distraction can be 
caused by other persons or environmental circumstances, such as noise, glaring display surfaces 
or surroundings that are too bright. Additionally run applications could distract the user with 
pop-up messages or sounds or hide part of the application. Inattention caused by distraction 
could lead to wrong, missing or incomplete diagnosis or wrong, missing or incomplete 
documentation of diagnostic results. 
 
As a portable DICOM viewer, which runs directly from a CD, DVD or memory stick, it is not 
necessarily part of a wider medical network. It only displays and processes the DICOM data 
placed onto the medium, but does not communicate with other stations either by DICOM protocol 
or otherwise. Where iQ-LITE is integrated into a burning device to be put on portable media, the 
respective institution should always use the latest software version and update existing 
installations when updates become available. 
 
As software applications, the devices do not function on their own. They can only be used in 
combination with computer hardware and software. The application’s use is limited to the 
computer hardware and software specified in the user documentation. The manufacturer only 
provides iQ-LITE for the defined medical purpose. The software alone is considered the medical 
device. Not included are any other components, hardware or software that may be needed to 
ensure the functioning of the workstation (e.g. operating system, portable media reading devices 
and displays). This also includes potentially needed runtime dependencies. But the effects of 
such components on the medical device itself are considered and managed. 
 
The capabilities and the performance of the iQ-LITE software can be affected by limitations and 
failures caused by the hardware or other software installed on the system. Therefore, the proper 
operation and the maintenance of the hardware are necessary. Instructions regarding hardware 
and software specifications as well as software maintenance given by the manufacturer must be 
adhered to. 
 
If the iQ-LITE software fails, the medical image data must be made available by other means for 
viewing and clinical diagnostics (e.g. use of original viewers of the image acquisition devices). 
 
Hygiene factors, such as sterility, or other physical parameters do not apply, since iQ-LITE is a 
software applications. But hygiene, sterility and physical and environmental conditions may have 
to be considered for the hardware on which the software is run or that iQ-LITE is used with (e.g. 
diagnostic displays). The instructions of the hardware manufacturers must be adhered to. 
 
 
1.2.5 Contraindications 
 
iQ-LITE is not intended for: 
 
 Use with unsupported imaging data (see iQ-VIEW/PRO DICOM Conformance Statement) and 

data incompliant with the DICOM standard. 
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 Use in system environments not specified as supported by the manufacturer (see Admin-
istration Guide).  

 Diagnostic reading or therapy decisions by using inappropriate medical displays. 
 Primary PET/CT reading 
 Radiation therapy planning 
 Pediatric echocardiography where rates > 50 frames per second are used 
 Mammography screening 
 
The use of iQ-LITE for the following procedures is limited and not recommended for regular 
use: 
 
 Pathology and microscopy images with ultra-high resolutions of > 150 MP. 
 Digital angiography, since no image subtraction is available. Missing image subtraction might 

lead to wrong diagnoses.  
 Digital mammography and digital breast tomosynthesis due to missing hanging protocols. 

Missing hanging protocols might delay the diagnoses. 
 Dental imaging due to missing teeth index. 
 
 
1.2.6 Product life-cycle 
 
It can be assumed that the iQ-LITE 3.1 software application life-cycle is limited to 5 years after 
the medical device has been initially placed on the market. The life-cycle of the medical device 
will be reduced in case updated versions of the software application are placed on the market. 
IMAGE Information Systems offers a 2 year transition period to the customers in order to change 
to an updated version. The manufacturer does not guarantee constant functionality and service 
when using the software beyond the life-cycle of the device. 
 
 
1.3 Warnings and precautions 
 
1. Misuse of the software 
 

 WARNING: 
Danger of misdiagnosis.  

Copies of this software marked as “Alpha”, “Beta” or “Preliminary” versions must – under no 
circumstances – be used for diagnostic purposes. 

H.-No.: 1.1.1 – 1.3.3 
 

 WARNING: 
The manufacturer does not assume liability for any misuse of the software or for any clinical 
outcome resulting from the use of the software. The software is made available to the user 

with the understanding that the software is only used as a means to aid processes or decisions 
that can be made without the use of the software.  

H.-No.: 1.1.1 – 1.3.3 
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 WARNING: 
iQ-LITE is only permitted for diagnostic use if all applicable legal requirements in your country 
are met. Consult your authorized local distributor before using the application for diagnostic 

purposes.  
H.-No.: 1.1.1 – 1.3.3 

 
 
2. Technical limitations of the software 
 

 WARNING:  
iQ-LITE is a 32 bit application. It can therefore not allocate more than 2 GB RAM to process 

DICOM images. This may lead to limitations in processing huge multi-frame objects. The 
following effects are possible:  

– It might become impossible to correctly decompress images that were stored in compressed 
form on the medium. This will result in failures to view these images in the viewer. 

– Uncompressed objects stored on the medium might still be too big for the viewer to handle 
this data successfully. This will result in a corrupted image display and issues while trying to 

process this data (e.g. browsing through the series, zooming, windowing, etc.). 
 

To keep the effects on iQ-LITE and on the opportunity to read these objects as low as possible, 
we recommend the following actions: 

– The creator of such media should not burn data onto the medium in compressed form. 
According to the recommendations concerning the creation of patient media, data should be 

exported to media always in uncompressed form. This is especially important in cases such as 
this. Best use Little Endian Explicit as exporting transfer syntax. 

– If it is possible that you receive iQ-LITE media with such huge multi-frame data volumes, use 
a 64 bit Windows operating system and more than 4 GB RAM. 

– Be sure to limit the number of other processes and applications running at the same time as 
iQ-LITE, so that the full 2 GB RAM can really be allocated to the processing of these objects. 
– If a study contains several such huge multi-frame objects in different series, you may load 

them individually (one after the other) into the viewer. This keeps the required RAM at a limit. 
H.-No.: 1.1.4, 1.1.5, 1.1.9, 1.2.1, 1.2.2, 1.2.4 

 
NOTICE: 

Due to a fair number of internal and external dependencies, the support of DICOM 
encapsulated PDF (as SOP class) is still limited in this software version. The manufacturer 
cannot guarantee the full functioning of DICOM encapsulated PDF objects throughout the 

application and, therefore, does not assume liability for any incorrect behavior. 
 
 
3. Behavior in case of software errors/failures 
 

 WARNING: 
Although the iQ-LITE software is subjected to extensive validation and verification procedures 
by the manufacturer, it is nevertheless possible that unforeseen display errors, deviations in 
measurements or failing processing may arise during use of the software. Users should at all 

times be aware and warned of such eventualities. In case faulty software behavior is observed 
that may put a patient or the user at risk, the user is asked to immediately contact the 
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manufacturers or local reseller. The manufacturer’s contact data is stated in the user 
documentation and inside the application itself. 

H.-No.: 1.1.1 – 1.3.3 
 
 
4. User competence and training 
 

 WARNING: 
Danger of misdiagnosis. 

The iQ-LITE software is certified as a medical device according to the European Council 
Directive 93/42/EEC. Before using this application, make sure that you have thoroughly read 

and fully understood the content of the Instructions for Use and Administration Guide, 
including all of the warnings and notices.  

H.-No.: 1.1.5, 1.1.7, 1.1.8, 1.1.10, 1.2.4 
 

 WARNING: 
Danger of misdiagnosis. 

This medical software does not replace the competence and judgment of qualified medical or 
radiological personnel in any way. It should only be used by qualified and trained persons, 
because any actions of the user may directly affect the accuracy of the functions and the 

results acquired with the help of the software. 
H.-No.: 1.1.5, 1.1.7, 1.1.8, 1.1.10, 1.2.4 

 
NOTICE:  

Acrobat Reader or another PDF reader must be installed/available on the system to open and 
view the iQ-LITE instructions for use, which is available as a PDF file directly on the iQ-LITE 

medium (MANUAL.PDF). 
 
 
5. Conditions of installation and use / software environment 
 

 WARNING: 
Danger of application failures. 

An iQ-LITE medium is not always created by iQ-VIEW. iQ-LITE can be integrated with 
automatic burning stations. When doing such an integration, the appropriate folder and file 
structure must be used to ensure that the iQ-LITE application will function faultlessly and is 

able to access the included DICOM data. Refer to the iQ-LITE Administration Guide for detailed 
information regarding the necessary folders and files. 

H.-No.: 1.1.1, 1.1.4, 1.2.3, 1.2.4 
 

 WARNING: 
Danger of data loss or inconsistency or application failures. 

When storing the iQ-LITE software and images on data carriers the medium should be stored 
in a way that it cannot be damaged (no scratching, no high temperatures, no contact to acid 

fluids, etc.). 
H.-No.: 1.1.1, 1.1.4 
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 WARNING:  
Danger of application failures or unavailability. 

All modifications to the medical software have to be made by IT service personnel. This 
includes the installation, verification as well as changes in the software. The risk of malfunction 

is relatively high when modifying software. Abnormal termination of the software as well as 
temporary or permanent data losses are possible when improperly administered. Therefore all 

modifications to the software are performed solely by service personnel. 
Modifying application folders and or files to different locations, deleting or renaming them 

without considering other parts may cause problems in the functioning of iQ-LITE. Keep the file 
and folder structure intact and only follow the user documentations’ instruction for configuring 

the application. 
H.-No.: 1.1.1, 1.1.4, 1.2.3, 1.2.4 

 
 WARNING: 

Danger of application failures or unavailability. 
When using iQ-LITE compatibility issues with other software are possible. Therefore, there 

should not be installed any other DICOM viewing software on the same system where iQ-LITE 
is run from a medium. 

H.-No.: 1.1.1, 1.1.2 
 

NOTICE: 
It might be necessary that some data from the patient CD/DVD must be cached on the local 
hard disk to be able to correctly display certain objects. Therefore, make sure that the user 

has sufficient rights to temporarily write data onto the hard disk. 
The user should best be a standard user on the computer. Administrator permissions are not 

necessary. 
 

 WARNING: 
Danger of misdiagnosis due to the use on non-specified system hardware and software. 

The use of system hardware and/or software that is not approved by the manufacturer might 
lead to non-diagnostic image output, such as limitations in the number of gray-scale shades, 

reconstruction artifacts or performance issues. It may also make the application unavailable or 
cause application failures and/or misbehavior. 

Refer to the system requirements information given in the user documentation. 
H.-No.: 1.1.1, 1.1.2, 1.1.7, 1.1.9, 1.2.1 – 1.2.4 

 
NOTICE:  

The use of iQ-LITE on virtual machines is not supported. The manufacturer does not extend 
warranty for the faultless use of the iQ-LITE software in such technical environments and 

cannot guarantee the diagnostic quality under such circumstances. 
 

 WARNING: 
Danger of misdiagnosis due to the use of wrong graphics card settings.  

This can occur when several displays are used, maybe even connected to different graphics 
cards. A wrong display of the aspect ratio might lead reading physicians to wrong 

interpretations. 
Make sure to run a system acceptance test before clinical use. 

H.-No.: 1.1.4, 1.1.5, 1.1.7, 1.1.9, 1.2.4 
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 WARNING: 
Danger of misdiagnosis due to use of non-calibrated displays. 

If iQ-LITE is used for diagnostic purposes the displays at the workstation needs to be 
(re)calibrated regularly according to DIN 6868-157 to guarantee the diagnostic quality of the 
displays. A quality check must be performed using a reference dataset. Its displays must be 
evaluated to ensure that there is no corruption in the display. The person doing these checks 

must make sure that the measuring device has a valid calibration status. 
H.-No.: 1.1.9 

 
 WARNING: 

Danger of misdiagnosis due to incorrect measurements. 
Inaccuracies of measurements are possible due to software design and user errors. The 

manufacturer has set acceptance criteria for such deviations that occur due to a malfunction of 
the medical device under best measurement conditions:  

- Deviations of +/- 5 % are accepted for distance and angle measurements in general as well 
as intensity/density measurements, e.g. in Hounsfield Units. 

- Only distance measurements longer than 10 mm are considered diagnostically relevant. 
The user is required to consider these conditions in his/her evaluation of measurements for 

diagnostic purposes. 
H.-No.: 1.3.1 

 
 WARNING: 

Danger of data loss/inconsistencies or application failures. 
Computer viruses hold a considerable risk. This risk is very high when reading in data carriers, 
which may potentially include viruses. A virus infection may potentially lead to data losses and 
to data inconsistencies. To avoid the risk of a virus infection of the computer, on which iQ-LITE 

is run, the system should be furnished with anti-virus software that needs to be updated 
regularly. 

H.-No.: 1.1.1, 1.1.4, 1.1.8, 1.2.3 
 

NOTICE:  
Anti-virus software or firewalls may affect the iQ-LITE software as they may accidentally block 
necessary application files or communication (e.g. ports). It is recommended to configure such 

applications accordingly to ensure the faultless running of iQ-LITE on the system. A system 
test should be performed before using it productively. 

 
 
6. Manipulated, incomplete, missing and/or compressed data 
 

 WARNING: 
Danger of false negative interpretations due to missing images. 

The application cannot detect if image data are missing. The user should carefully check the 
completeness of a study according to institutional acquisition protocols. In some cases, the 
DICOMDIR (registration file for all DICOM content) may be incomplete or corrupted. It is 
recommended to try to manually read in the DICOM content again by using the available 

function button within the iQ-LITE study browser. 
H.-No.: 1.1.5 
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 WARNING:  
Danger of wrong or incomplete diagnosis. 

Skipping images when browsing through series while reading or reviewing studies could lead to 
missing diagnostically relevant images. Use the skipping options carefully and always browse 

all images to provide best diagnostic results. 
H.-No.: 1.1.9 

 
 WARNING: 

Danger of misdiagnosis due to the use of lossy image compression. 
Excessive compression levels may cause compression artifacts that might reduce the image 

quality to non-diagnostic level. These images may therefore no longer be usable for diagnostic 
purposes! 

If the system detects the use of any lossy compressed images, the application marks these 
images accordingly with a “Lossy compression” label.  

H.-No.: 1.1.5, 1.1.9 
 

 WARNING 
For users under the jurisdiction of the U.S. Food and Drug Administration (FDA) 

Danger of misdiagnosis due to lossy image compression in mammography. 
Currently the FDA does not permit images regenerated from lossy compressed data to be used 

in the same manner as the original mammogram. As a consequence, lossy compressed 
mammography images must neither be reviewed for primary diagnosis or final image 

interpretation nor be stored for retention purposes. 
Only use original (uncompressed) or lossless compressed images for diagnostic purposes to 

ensure that the images are displayed and processed in FDA approved diagnostic quality. 
The application indicates a current or previous lossy compression of an image in the viewer's 

text overlay. Make sure to activate the text overlay display to see the respective warning 
information. 

H.-No.: 1.1.9 
 

 WARNING: 
Danger of delayed diagnosis or misdiagnosis due to missing or incorrect image display. 

It cannot always be ensured that compressed data can be displayed or processed in iQ-LITE or 
that this data can be read in successfully by a different system. It is highly recommended not 

to store compressed DICOM objects on a patient medium. 
H.-No.: 1.1.2, 1.1.4, 1.1.9, 1.2.4 

 
 WARNING: 

Danger of misdiagnosis due to inappropriate image data. 
The web content (HTM and JPEG files) on an iQ-LITE medium is not intended for diagnostic 

purposes. The JPEG files are not available in diagnostic quality. The user will have to refer to 
the included DICOM images that can be viewed with the help of the iQ-LITE software or 

imported into another diagnostic viewer or archive.  
H.-No.: 1.1.7 
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7. Security and protection of patient data 
 

 WARNING:  
Danger of unauthorized access to patient information. 

Portable media containing patient and study data must be handled with appropriate care. It 
must not be left lying around, allowing unauthorized access to the information. Such media 

should be stored in locked cabinets or imported and stored in a digital archive that can only be 
accessed by authorized personnel. 

H.-No.: 1.1.8 
 
Any further warnings or precautions regarding individual functions of iQ-LITE are documented in 
the respective sections of the iQ-LITE Instructions for Use and the iQ-LITE Administration Guide. 
 
 
1.4 System requirements 
 

NOTICE: 
The system requirements stated below are the requirements and recommendations valid at the 

release of this software version and/or the release date of this document.  
This information is subject to change over the course of the product’s life-cycle. The manu-

facturer will inform about updates regarding the system requirements when iQ-LITE becomes 
available for systems other than those defined below (e.g. newer operating systems). Contact 

your reseller or the manufacturer for the latest information.  
Keep in mind that iQ-LITE as a medical device will not automatically support any new 
technology that becomes available on the market. The software will have to be tested 

according to legal regulations before being released for such systems.  
 
 
1.4.1 General hardware and software requirements 
 
For iQ-LITE the system requirements concerning both hardware and software are: 
 
 Intel Multi-Core CPU with ≥ 2 GHz 
 ≥ 4 GB main memory  
 ≥ 500 GB S-ATA II hard disk drive (HDD) 
 Graphics card, resolution of 1280x1024 or more, True Color mode (24 bit) or at least 8 bit 

gray output, any nVidia or AMD graphics card with ≥ 1 GB RAM  
 1x digital color or grayscale display ≥ 19” for demonstration; 1 or 2 high-resolution displays 

as diagnostic displays with up to 3 MP 
 Windows 7, Windows 8, Windows 8.1, Windows 10; each with 32 or 64 bit; for all OS 

Professional edition or higher, with latest service packs  
 Adobe Acrobat Reader, version XI 
 CD/DVD drive for the reading of iQ-LITE patient media 
 Mouse with scroll wheel 
 PostScript printer 
 DELL or HP hardware 
 
Also pay attention to the hardware requirements of the supported Microsoft Windows versions. 
Check the Microsoft website at www.microsoft.com for further details. 

http://www.microsoft.com/
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The web content on the CD/DVD/memory stick can be viewed using the following web browsers:  
 
 Internet Explorer (any version, preferably latest version for used OS) 
 Mozilla Firefox (any version, preferably latest version for used OS) 
 Google Chrome (any version, preferably latest version for used OS) 
 

NOTICE: 
It might be necessary that some data from the patient CD/DVD must be cached on the local 
hard disk to be able to correctly display certain objects. Therefore, make sure that the user 

has sufficient rights to temporarily write data onto the hard disk. 
The use of iQ-LITE media in virtual machines as well as in terminal server environments is not 

supported. The manufacturer does not extend warranty for the faultless use of the iQ-LITE 
software in such technical environments and cannot guarantee the diagnostic quality under 

such circumstances. 
 

NOTICE: 
Beware of the fact that the use of enlarged text and other items on the desktop may have 

negative effects on the display of iQ-LITE tabs, menus and items. It is, therefore, 
recommended to use the default 100% settings for the displays.  

 
 
1.4.2 Additional system requirements 
 
1.4.2.1 Specific system requirements for Unicode languages 
 
Specific system requirements for use with Unicode languages (Japanese, Russian, etc.) include: 
 
 Min. Windows 7 Professional operating system, 32 bit, in native language 
 For a correct display of patient and study information within the application (information on 

DICOM level), the original DICOM data has to be correctly encoded with the appropriate 
DICOM character set (e.g. for Japanese DICOM sets encoding in the DICOM character sets 
ISO_IR 13, ISO 2022 IR 87 and/or ISO 2022 IR 159). 

 
NOTICE:  

A complete list of all generally supported specific character sets (i.e. DICOM objects already 
encoded with a specific character set) can be found in the main application’s (iQ-VIEW/PRO) 

DICOM Conformance Statement. Nevertheless, the adherence to the above-mentioned system 
requirements still remains. 

 
 
1.4.2.2 DICOM storage format for media 
 
Storing data on patient CD/DVD/memory stick in uncompressed form: 
 
DICOM data should always be copied onto media in an uncompressed format (transfer syntaxes 
Little Endian Explicit or Little Endian Implicit). This is recommended also by radiological societies.  
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It ensures high compatibility with other systems, e.g. when the data shall be imported into 
existing systems. The support of compressed transfer syntaxes, on the other hand, cannot be 
expected. 
 
It also ensures a correct image display in the iQ-LITE viewer and additionally speeds up the 
display of images, sometimes considerably. The reason is that if images are stored on a medium 
in compressed form, they still have to be decompressed on-the-fly when they shall be displayed. 
This will take a certain amount of time. 
 
 
1.4.2.3 Specific system requirements for display of DICOM-encapsulated PDF 

objects 
 
Generally, iQ-LITE is able to display DICOM-encapsulated PDF objects. However, specific system 
requirements apply to be able to do so: 
 
 Windows 8 and Windows 10 use specific apps as default for the display of PDF files. These 

apps cannot be used for the display of DICOM-encapsulated PDF files in iQ-LITE. Acrobat 
Reader in a supported version must be available on the system. 

 
 
1.4.2.4 Ensuring system security 
 
It is recommended that the application is used only within a secured environment as iQ-LITE 
does not support any specific security measures. A secured environment includes at a minimum: 
 
 Firewall or router protections to ensure that only approved external hosts have network 

access to the computer, on which iQ-LITE is used. 
 Firewall or router protections to ensure that the computer, on which iQ-LITE is used, only 

has network access to approved external hosts and services. 
 Any communication with external hosts and services outside the locally secured environment 

uses appropriate secure network channels (e.g. such as a Virtual Private Network (VPN)). 
 A regularly updated anti-virus/malware software. 
 
We recommend the use of up-to-date anti-virus software on the computer on which iQ-LITE is 
run or integrated into a CD/DVD robot system or burning station. The virus definitions must be 
updated regularly (they should not be older than 2 weeks). 
 
Other network security procedures such as automated intrusion detection may be appropriate in 
some environments. Additional security features may be established by the local security policy 
and are beyond the scope of these instructions. 
 

NOTICE:  
Anti-virus software or firewalls may affect the iQ-LITE software as the application itself must 
be started from a removable medium and the data will also be read from the medium. It is 

recommended to configure such applications accordingly to ensure the faultless running of iQ-
LITE on the system. A system test should be performed before using it productively. 
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1.5 Software maintenance 
 
The software itself needs no maintenance. 
 
However, when using the iQ-LITE software (e.g. after receiving a respective medium), the 
capabilities and the performance of the iQ-LITE software can be affected by limitations and 
failures caused by the hardware or other software installed on the system. Therefore, the proper 
operation and the maintenance of the hardware are necessary (e.g. professional connection to 
power, sufficient ventilation, regular cleaning of the fan, etc.). Instructions regarding hardware 
and software specifications as well as software maintenance given by the manufacturer must be 
adhered to.  
 
 
1.5.1 Calibration and recalibration of diagnostic displays 
 
Where the iQ-LITE software is used for diagnostic purposes, it is necessary to regularly 
(re)calibrate the displays and monitors of the iQ-LITE workstations according the laws and 
regulations concerning image reading devices.  
 

 WARNING: 
Danger of misdiagnosis due to use of non-calibrated displays. 

If iQ-LITE is used for diagnostic purposes the displays at the workstation need to be 
(re)calibrated regularly according to DIN 6868-157 to guarantee the diagnostic quality of the 
displays. A quality check must be performed using a reference dataset. Its displays must be 
evaluated to ensure that there is no corruption in the display. The person doing these checks 

must make sure that the measuring device has a valid calibration status. 
H.-No.: 1.1.9 

 
 
1.5.2 Ensuring sufficient hard disk space 
 
For created patient media the concept of sufficient hard disk space can become relevant. By 
default, the DICOM data written onto the media is read directly from the medium. However, iQ-
LITE also offers the option to temporarily cache the DICOM data on the hard disk for faster 
browsing. To do that, additional hard disk space is necessary and the system must be enabled 
to accept data from removable media for caching. It should be checked regularly – once per 
quarter is recommended – if enough storage capacity is still available on the hard disk to 
temporarily cache patient studies on the local hard drive.  
 
 
1.5.3 Protection from virus/malware infection 
 
Computer viruses and malware hold a considerable risk. On computers, where iQ-LITE media 
are used, this risk is very high because data carriers may potentially include viruses.  
 
A virus/malware infection may potentially lead to data losses and to data inconsistencies. To 
avoid the risk of a virus infection of the computer, on which iQ-LITE is running, all systems 
should be furnished with anti-virus software that needs to be updated regularly. Updates should 
be run as soon as they become available, but at least every two weeks. 
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Anti-virus/anti-malware checks should also be run regularly on computers where iQ-LITE is used. 
It is recommended to run a check at least once a week and after definition updates.  
 

NOTICE:  
Anti-virus software or firewalls may affect the iQ-LITE software as the application itself must 
be started from a removable medium and the data will also be read from the medium. It is 

recommended to configure such applications accordingly to ensure the faultless running of iQ-
LITE on the system. A system test should be performed before using it productively. 
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2 Installation and licensing 
 
2.1 Installation of iQ-LITE  
 
The iQ-LITE software is usually provided on a patient CD, DVD or memory stick. It does not need 
to be installed. The viewer opens automatically when the medium is inserted into the computer, 
provided that the auto-run command was written onto the medium and the auto-run function is 
enabled on the system.   
 
If the software does not start automatically, select the correct drive (e.g. CD, DVD or memory 
stick drive) in the Windows Explorer and double-click the file “Lite.exe” to start the viewer 
manually.  
 
The web content, if burned onto the CD in addition to the DICOM images and the iQ-LITE viewer, 
can be accessed by double-clicking the INDEX.HTM file and will be opened in the default or 
specifically selected internet browser.  
 
 
2.2 Uninstalling iQ-LITE  
 
Since the iQ-LITE software does not have to be installed before using it, but runs directly from 
the portable medium (CD, DVD or memory stick), there is no need to uninstall the application. 
Simply remove the medium from the computer following the instructions to do so. 
 
 
2.3 Licensing of iQ-LITE  
 
The iQ-LITE software does not need a particular license to be run from a medium. When you are 
provided with a patient CD, DVD or memory stick, you may open the viewer as often as you 
wish or need. The limitations to the running of that software are described in the “End User 
License Agreement” stated in the “README.TXT” file that can be found on every iQ-LITE medium.  
 
Also, the iQ-LITE viewer is limited in functionality and features. For the fully functional 
radiological workstation, including all features, we recommend using iQ-VIEW or iQ-VIEW PRO. 
If you are interested in purchasing the software, contact IMAGE Information Systems Europe 
GmbH or a local reseller. A trial version can be downloaded at www.image-systems.biz.  
 
 
 
 

http://www.image-systems.biz/


 

 

 
PD-730-154 iQ-LITE 3.1 Instructions for Use PUB INT EN – 001R 24 

 

 

 

 

 

 

 
 
 

 

3 Configuration 
 
There is no need to configure the software before using it. All necessary configuration settings 
are already provided with the patient CD, DVD or memory stick. 
 
The software includes functions that can be customized for a running viewer session. 
 

NOTICE: 
It might be necessary to cache some data from the patient CD/DVD onto the local hard disk in 

order to correctly display certain objects. Therefore, make sure that the user has sufficient 
rights to temporarily write data onto the hard disk.  
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4 Use of the software application 
 
4.1 Study browser  
 

 
iQ-LITE study browser 

 
 
4.1.1 Visual style 
 
The institution that created the iQ-LITE medium may have configured the use of a different visual 
style for the application, e.g. a dark style for a more comfortable working experience in darkened 
reading rooms. 
 
Consequently, the application windows may look different from what is shown here in the in-
structions for use, which refers to the default Windows style of the underlying operating system. 
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4.1.2 Study table 
 
When iQ-LITE is started, the medium will be scanned for a DICOMDIR file, which is a register of 
all studies including their series and images/reports contained on the medium. If found, the file 
will be read and the study browser window opens and lists all studies that are available on the 
medium in the study list. If no DICOMDIR is found, the entire medium is scanned for DICOM 
objects instead. The study table presents the data. 
 
At first only the study table is shown in the study browser window. The “Preview icons” panel at 
the bottom of the window is closed and may be opened if desired. See below for further 
information on the use of the preview icons.  
 
 
4.1.2.1 Rescanning the medium 
 

 
This option in the lower right corner of the study browser allows to 
rescan the medium for DICOM objects. It can be used when there is a 
suspicion that not all available data might be listed in the study browser, 
which could happen if the DICOMDIR file does not contain all images or 
the references are wrong. 

 
 
4.1.2.2 Accessing the instructions for use  
 

 

Clicking the “Help” button in the lower left corner of the study browser opens the iQ-
LITE instructions for use for consultation.  
 

 
NOTICE:  

Acrobat Reader or another PDF reader must be installed/available on the system to open and 
view the iQ-LITE instructions for use, which is available as a PDF file directly on the iQ-LITE 

medium (MANUAL.PDF). 
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4.1.2.3 Study information given in the study table 
 
The study table presents a certain amount of information about every study that is listed. The 
table gives information about a study on three levels: 
 
 Study level: Gives the most important information provided at the study level. 
 Series level: Provides information about the available series in a study. 
 Image level: Allows access to a preview of each image in a series, including the possibility 

to use window leveling. 
 
On study level, the following information can be found: 
 
 Modality: Lists all modalities of which data is included within the study. 
 Sex: States the patient’s sex. 
 Patient name: Gives the name of the patient in the format “Last name, First name”. 
 Patient ID: States the ID under which the patient was registered in the patient information 

system of the media creator. 
 Date of birth: Shows the patient’s date of birth. In brackets you will additionally find the 

patient’s age at the time when the study was performed. Necessary for the calculation of the 
patient’s age are a valid date of birth and a valid study date. The age is presented as follows: 
- In years (Y) for all patients older than one year, e.g. (34Y) 
- In months (M) for all patients older than one month but younger than one year, e.g. 

(11M) 
- In weeks (W) for all patients older than one week but younger than one month, e.g. (3W) 
- In days (D) for all patients younger than one week, e.g. (6D) 

 Study date: Gives the date on which the study was performed. 
 Referring physician: States the name of the physician who referred the patient. 
 Description: Shows the study description. 
 Accession number: Gives the accession number applied to the study. 
 Study time: Gives the time when the study was performed. 
 
On series level, the following information can be found: 
 
 Series number 
 Series description 
 Modality 
 Patient position 
 Body part 
 Series date 
 Series time 
 
On image level, the following information can be found: 
 
 Image number 
 Image type: This defines whether the images you are about to view are primary/original or 

derived images. 
 Slice location: Is used for cross-sectional images, such as CT and MR. 
 Number of frames: Is used for multi-frame objects, where one image object contains a 

number of images, e.g. in US. 
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4.1.2.4 Navigating the study table 
 
To see the next level underneath a study, click the “+” box on the far left side. This will open 
the study to show the various series, including any relevant information. By clicking the “+” to 
the left of a series, the image level will open, revealing a table of all available images in that 
series.  
 

 
 

 
Clicking the eye icon beside an image entry will open the chosen image in a 
preview window. Center/window changes are possible using either the left or 
center mouse button. 

 
 
4.1.2.5 Sorting studies in the study table 
 
By clicking the respective entry in the table header, the available studies can be sorted by patient 
name, modality, patient ID, study date etc. – in both ascending and descending order. The 
sorting direction is noted in the column heading by an up or down arrow and is reversed when 
the heading is clicked another time. 
 
 
4.1.2.6 Selecting studies and series 
 
The selection of studies in the study table follows the usual Windows logic of using [CTRL] and 
[SHIFT] for selecting. Making selections at the series level requires alternative methods: 
 
 Select an individual study either by clicking anywhere in the study entry line or by clicking 

the checkbox in the first column.  
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 Multiple studies can be selected together by either using [CTRL] to mark the studies 
separately or using [SHIFT] to mark all studies between the first item selected and the last 
one. Alternatively, the checkboxes of the desired studies can be selected in the first column. 

 Select an individual series by clicking the “+” next to the study in which the series belongs 
and marking the checkbox in front of the desired series entry.  

 To select multiple series of one study, simply mark the checkboxes of all required series after 
displaying them by clicking the “+” next to the appropriate study containing the series. 

 Using the same method, individual series from different studies can be selected. 
 

 

Right-click the table header in the study table to open a sub-menu 
where all studies available on the medium can be selected or 
unselected at once. 

 
NOTICE: 

Selected studies and series are marked orange. In addition the checkbox of each study / series 
in the first column will be marked.  

For best practices, data should be selected either on the study level or the series level only. 
When mixing study and series levels, selecting series and studies by using the checkbox 

(instead of a simple click into the line) will be helpful to assure that the entire selection can be 
loaded into the viewer. 

 
 
4.1.2.7 Loading studies and series into the viewer 
 
If only one study or one series shall be selected from the study list to be loaded into the viewing 
area, one of the following options can be used: 
 
 Double-click an unselected study/series to load it into the viewer 
 Select the study / series and then click the “View” button 
 

 

If more than one study or series (or combination of studies and series) shall be viewed, 
click the “View” button to load the entire selection into the viewer. Double-clicking a 
selection will only load the study/series under the mouse pointer. 

 
 
4.1.3 Preview icons panel  
 
The “Preview icons” panel can be opened and closed using the switch   in the upper left 
corner of the panel (vertical when the panel is open and horizontal when the panel is closed).  
 
This panel shows the preview images of the currently marked study or series:  
 
 If a study is marked, previews of all series of that study are shown.  
 On series level, more than one series can be selected and the images of these series are 

displayed as preview thumbnails. 
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NOTICE:  
The preview thumbnails display in the study browser is only possible if the web content (HTM 
pages) including the JPEG images was also burned on the medium. Otherwise, this panel will 

not exist. 
 
 
4.1.4 Caching data on hard disk 
 
Generally, the images and reports are directly read from the medium into the memory and then 
shown in the viewer. Access to such studies is faster but browsing is slower. At the bottom of 
the study browser the option “No caching (slower browsing but faster access)” is active. This is 
the default setting. 
 
If the second option “Cache images on hard disc” is activated, the images and reports from the 
medium will temporarily be saved to the hard disc. With this setting activated, access of the data 
will initially take a little longer, but browsing through the series afterwards will be faster.  
 

NOTICE: 
To cache data on the local hard disk the user must have sufficient rights to temporarily write 

data onto the hard disk. 
 
 
4.1.5 Accessing the viewer 
 
The “View” button is located in the tool bar on the left side of the study browser window. 
 

 

The button is used to access the viewer window and load images and reports for 
reading and processing. After one or more studies or series are selected from the 
study list, use the button to load them into the viewer. Also refer to sections 4.1.2.6 
and 4.1.2.7. 

 
For detailed information on how to use the viewer application as well as a description of all 
available features and processing functions, see section 4.2). 
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4.2 Viewer  
 

 
iQ-LITE viewer window 

 
 
4.2.1 The series preview bar 
 
The series preview bar can be used to get an overview over the studies loaded into the viewer. 
It gives information about the different series of the loaded studies and allows the navigation 
between studies. 
 

 
 

 WARNING: 
Danger of incomplete data. 

The series preview bar of iQ-LITE can only display up to 199 series. It is not possible to 
correctly load studies that contain more than 199 series. In those very rare cases where such 
a study is provided on the medium, you may select a number of series in the study browser to 

load into the viewer instead of loading the entire study. 
H.-No.: 1.1.5 
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4.2.1.1 Information in the series preview bar 
 
The viewer will display either one or two series preview bars. On a single display system, just 
one preview bar will be displayed when only one study is loaded into the viewer. If several 
studies are loaded, at first only one preview bar will open with the series information of the first 
study, but it is possible to open a second one, displaying the next study. 
 

 

In the series preview bar, all available series of a study 
are displayed with one thumbnail representing each 
series. By default, the thumbnail will be taken from the 
middle of the series to be more representative for the 
series. In series with only two images, a preview of the 
first will be shown. It is possible to configure iQ-LITE to 
use the first image/frame of a series instead. This would 
have been done by the institution that created the 
medium. 

 
The series currently active in the image processing area will be shown with an orange frame in 
the series preview bar for easier orientation. 
 
Each series thumbnail displays a number that corresponds to the number of images included in 
the series. In case of multi-frame objects, the number of available frames will be displayed. 
 
 
4.2.1.2 Functions of the series preview bar 
 
The series thumbnails in the preview bar can be used to populate the views in the image 
processing area – both on single and dual display systems – by: 
 
 Dragging a series from the preview bar to an available view of your choice 
 Double-clicking a series thumbnail to load it into the currently active view (orange frame)  
 
Below is a description of the various buttons that may be found in the series preview bar. They 
are only visible, if more than one study is loaded into the viewer: 
 

 Clicking the forward button will open the next study in the image processing area (on the 
primary display in dual display systems). 

 
 Clicking the backwards button will open the previous study in the image processing area 

(on the primary display in dual display systems). 
 

 Clicking the plus button, on single-monitor systems, opens a second series preview bar 
with the thumbnails of the second study loaded into the viewer. If more than two studies 
are loaded, a click on the plus button opens a sub-menu with all other available studies 
for selection. On dual display systems, the second preview bar is automatically shown on 
the second display. A click on the plus button can be used to switch to another loaded 
study, using the sub-menu that lists all studies currently available in the viewer. 
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 For this button to appear the second preview bar must additionally be open. It is used to 
close the second series preview bar on single display systems. It is not possible to close 
the second preview bar when working with dual displays. 

 
 
4.2.1.3 Size of series preview bar 
 
Depending upon the needs of the user, it is possible to configure the size of the series preview 
bar. More space can be given to the image processing area by reducing the size of the preview 
bar. On the other hand, better viewing of the images in the preview bar can be achieved by 
enlarging its size.  
 

 
 
To set the size of the series preview bar: 
 
 Click the “Additional settings” menu. 
 Point to “Size of series preview bar” so that the additional side menu appears. 
 Select the desired size of the series preview bar – “Small”, “Medium” or “Large”. 
 
To either hide or show the series preview bar: 
 
 Click the “Additional settings” menu. 
 Point to “Size of series preview bar” so that the additional side menu appears. 
 Hide or show the series preview bar by selecting either “Hide” or “Show”. Alternatively, this 

can be done using the switch on the left border. 
 

 =  
You can easily hide or show the series preview bar by using the switch on the left 
side of the series preview bar. 

 
 
4.2.2 The study tabs 
 
Between the series preview bar and the image processing area a tab bar is displayed that 
contains a study tab for each study currently loaded into the viewer.  
 

 
 
Each tab states information about the study to easily identify a study. It contains (if available): 
 
 Patient name 
 Patient’s date of birth 
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 Type of study (modality information) 
 Study description 
 Study date 
 
The tab of the study currently active in the image processing area is highlighted in orange. 
 
Clicking another study tab will load that study into the image processing area (on dual display 
systems: image processing area of the primary display).  
 

 
If not all study tabs fit on the screen, use the arrow buttons to navigate. 

 
By default, iQ-LITE automatically sorts the studies loaded together into the viewer according to 
the study date and time, starting with the most current study and ending with the oldest. The 
study tabs are listed in the same order with the most current study displaying first on the primary 
display.  
 

NOTICE: 
The institution that creates the medium has the opportunity to configure iQ-LITE in a way that 

presents the oldest study first and moves from the oldest to the newest. 
 
 
4.2.3 The image processing area 
 
The image processing area is the main work area of the viewer window in which the loaded 
images are displayed and processed (refer to section 4.2). Changes (e.g. windowing, zooming/ 
panning, flipping/rotating, etc.) and additions (e.g. measurements and annotations) to images 
are made in the image processing area. 
  
When the viewer is opened with the selected data, the studies are loaded into the image 
processing area as follows: 
 
 One study is loaded on a single display setup: The study is displayed in the image processing 

area.  
 One study is loaded on a dual display setup: The study is displayed in the image processing 

area of the primary viewer display only (not spread across two displays). 
 Two or more studies are loaded on a single display setup: The first study is displayed in the 

image processing area. The others can be selected via their study tabs. 
 Two or more studies are loaded on a dual display setup: The first study is displayed on the 

primary display and the second study on the second display. The others can be selected via 
their study tabs. 
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4.2.3.1 Ruler and orientation indicators 
 

 

The ruler on the right side of each view indicates the size of the displayed image. The 
measurement is given in centimeters (cm), each segment comprising 1 cm; the total 
length being 4 cm. 
 
The ruler is not shown if the “Pixel Spacing” attribute or Ultrasound region calibration 
information is missing in the DICOM header of the image.  

 

 
Image with orientation indicators 

 
The orange markers in the images are orientation indicators. These indicators help to determine 
the orientation of an image, e.g. right or left, top or bottom. The indicators will remain in the 
correct position even if an image is flipped or rotated. Indicators will be denoted as follows: 
 
 R = right 
 L = left 
 H = head  
 F = foot  
 A = anterior 
 P = posterior  
 
Combinations of these indicators are also possible. 
 
 
4.2.3.2 Screen tiling options 
 
When a study contains more than one series or a series includes several images, it can be helpful 
to divide the image processing areas into several views. Therefore, it is possible to see several 
series at once or to compare series with each other. In addition, a series can be split within one 
view to display all of its images or to show the individual frames of a multi-frame image. These 
tiles can be individually selected by clicking them. An orange frame is displayed around the 
selected tile. 
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Screen tiling with series view and tiling on the image level 

 
Screen tiling options are accessible by: 
 
 Using the screen tiling button in the bottom toolbar 
 Selecting the “Tiling” option in the “Tools” menu 
 

 

The screen-tiling function allows splitting the image processing area both on the series 
level and on image level. On series level, the image processing area will be divided 
into the selected number of views. On image level, the active view itself will be divided 
into segments.  

 
The same tiling options are available on both the series and image levels:  
 
 1x1 
 2x1 
 3x1 
 4x1 

 1x2 
 2x2 
 3x2 
 1x3 

 2x3 
 3x3 
 4x3 
 3x4 

 4x4 
 5x5 

 
When accessing the screen tiling options via the “Tools” menu, the same sub-menu will open for 
the selection of the appropriate tiling. 
 

NOTICE: 
When using tiling at image level, browsing will occur from one image to the next, not from one 
page (of images) to the next page. For example, with a 2x2 image tiling, images 1 through 4 
will appear first. When browsing forward, images 2 through 5 will appear next, instead of the 

next “page” of images with images 5 through 8.  
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4.2.3.3 Automatic tiling and loading 
 
 “Automatic tiling”: During the loading process of a study, the application counts the number 

of available series and automatically divides the image processing area into the appropriate 
tiling. The automatic tiling is activated by default and cannot be deactivated.  

 
 “Automatic loading”: The viewer automatically loads the different series of one study into the 

preset tiling: e.g. the first series when working with a 1x1 tiling, two series with a 2x1 or 1x2 
tiling. In combination with “Automatic tiling” all available series are loaded automatically in 
the appropriate tiles. The automatic loading is activated by default and cannot be deactivated. 

 

 
 
 
4.2.4 The bottom toolbar 
 
The bottom toolbar offers the opportunity to easily access the most important image processing 
functions with just one click.  
 
Moving the mouse to the bottom of the screen will display the bottom toolbar. The individual 
functions of the buttons are described in the respective sections of these instructions for use. 
Some buttons have settings that are accessible by right-clicking the button.  
 
When a tool is selected an orange frame appears around the button to show that it is currently 
active. In some cases the orange frame can also indicate that an image was modified using a 
particular function: 
 
 An orange frame around “Color scheme” means that color scheme changes were made to an 

image (e.g. inverted). 
 An orange frame around “Flip/Rotate” indicates that an image has been rotated or flipped. 

Additional indicators will be added to the text overlay of the affected image(s) denoting the 
modification. 

 An orange frame around “Text overlay” is visible when the text overlay is active. This setting 
is enabled by default when a study is loaded into the viewer. 

  
 
4.2.4.1 Fixing the bottom toolbar 
 
Usually the bottom toolbar is hidden to increase the space available for image display in the 
image processing area. It only appears when the mouse is moved to the bottom of the screen. 
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However, it is also possible to fix the toolbar so that it is constantly visible and does not 
automatically hide. Do note that since settings cannot be stored permanently on a medium, the 
settings will not be remembered for the next start of the application. 
 

 
 
To fix the bottom toolbar: 
 
 Click the “Additional settings” menu. 
 Select “Fixed bottom toolbar”. 
 
 
4.2.4.2 The default bottom toolbar 
 
iQ-LITE comes with a default bottom toolbar containing twelve general image processing tools 
as well as the “Close viewer” button. While it is possible in iQ-VIEW/PRO to configure this toolbar, 
this option is not available in the iQ-LITE version. 
 

 
iQ-LITE toolbar 

 
 
4.2.5 The side toolbar 
 
The side toolbar contains additional functions that may be helpful to the user. They allow to 
apply different presentation modes to the images displayed in the image processing area, such 
as the visualization of scoutlines or the synchronization of different series. 
 
To access the toolbar, move the mouse to the left side of the screen.  
 
 
4.2.5.1 Fixing the side toolbar 
 
Usually the side toolbar is hidden to increase the space available for image display in the image 
processing area. It only appears when the mouse is moved to the left side of the screen. 
 
However, it is also possible to fix the toolbar so that it is constantly visible and does not 
automatically hide. Do note that since settings cannot be stored permanently on a medium, the 
settings will not be remembered for the next start of the application. 
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To fix the side toolbar: 
 
 Click the “Additional settings” menu. 
 Select “Fixed side toolbar”. 
 
 
By moving the mouse to the left border of the screen, the hidden side toolbar will open and offer 
the following presentation mode options:  
 
 
4.2.5.2 Sync 
 

 

“Sync” synchronizes different series at the current position, even if the images of 
those series have a different slice thickness. Activating the button will synchronize 
all series displayed in the image processing area. 

 

All views are included in the synchronization; each view will show a small  icon in the upper 
right corner to indicate its status. To deactivate the function, click the “Off” button at the bottom 
of the side toolbar (refer to section 4.2.5.6). 
 
Synchronizing only selected series: 
 
The synchronization of series is also possible by selecting multiple series in the image processing 
area. The activated (reference) series is the view with the orange frame. To select additional 
series, hold the [CTRL] key down while left-clicking other series’ views.  
 

The  icon will be displayed for those views included in the synchronization. The mouse wheel, 
the scrollbar or [] and [] arrow keys can now be used to scroll through the series in a 
synchronized way. The currently selected tiling scheme determines how many series are allowed 
to synchronize with the reference series.  
 
It is possible to switch between the reference series and another or work within the images (e.g. 
adding measurements, adjusting the windowing) without losing synchronization. 
 

To exclude a view from being synchronized, either click the  icon within the respective view 
or left-click the view while pressing the [CTRL] key. To deactivate the synchronization entirely, 
click the “Off” button at the bottom of the side toolbar (refer to section 4.2.5.6). 
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4.2.5.3 Bind 
 

 

Using the “Bind” tool, all currently loaded series of one study will be virtually bound 
together in one view. This allows the user to scroll through all series without switch-
ing from one view to the next (stack mode) or run through the series automatically 
(cine mode). The view will automatically switch to the next series when it reaches 
the last image in the current series. The series preview bar indicates the currently 
active series with an orange frame. 

 
Two common examples for the use of the “Bind” mode would be to easily browse through 
brainstem and brain tissue as if they were one series or to browse through a whole MR with a 
lot of sequences. 
 
 
4.2.5.4 Scope 
 
The “Scope” (or viewport) function determines whether changes made to an image (e.g. window-
ing, zoom/pan, flip/rotate, etc.) are applied only to the current image or to all images in the 
series. 
 
The “Scope” sub-menu is accessible by right-clicking the “Scope” button. Once the sub-menu is 
displayed, select “Series” to apply changes on the series level or “Image” to only change 
individual images. 
 

 
 

 

“Series scope”: Modifications made to the currently active image will be applied to 
that image as well as all other images in the series. This includes modifications such 
as windowing, zoom/pan, flip/rotate, color schemes and image filters. 

 

 

“Image scope”: Modifications made to the currently active image will only be applied 
to that particular image. This includes modifications such as windowing, zoom/pan, 
flip/rotate, color schemes and image filters. 

 
NOTICE: 

The scope selected for one series will be used globally for all other series of the same study. If 
the scope selected for one series is changed while processing a different series, the scope-

based changes of the first processed series will be reset. 
 
If tiling is done at the image level and “Image scope” is used, the image desired for modification 
may be selected by clicking the tile that displays that image. An orange frame will be shown 
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around the selected tile. Now image processing functions such as filters, zoom or flip/rotate can 
be applied to the image: 
 

 
 
 
4.2.5.5 Lines 
 

 

“Lines” is a scoutpilot function for easier orientation within a study. It is particularly 
helpful in multi-slice studies taken from different section planes. When activated, the 
position of the current slice will be displayed in the other series and section planes. 

 
NOTICE:  

iQ-LITE offers an additional orientation tool – the scoutpilot. For information about this tool, 
see section 4.2.18. 

 

 
Lines display 
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Sometimes the scoutline appears as a rectangle or parallelogram. This happens when the section 
planes are oblique. 
 
The following example shows this clearly: the third series is the reference series (orange frame). 
Scoutlines are applied to series 1 and 2. Since the section plane in series 3 is in a non–
orthogonal, oblique relation to the other planes, the scoutlines displayed in series 1 and 2 cannot 
be shown in a line but need to include the obliqueness. They are therefore displayed as 
parallelograms. 
 

 
Lines display including obliqueness 

 
Under certain circumstances the oblique lines display may complicate the orientation. The iQ-
VIEW/PRO workstation offers a 3D position display for easier orientation (not available in iQ-
LITE). However, another scoutlines mode may be used to additionally display the intersecting 
lines or to only display the intersecting lines and remove the display of the oblique plane 
projection (refer to section 4.2.18.3). 
 
In other cases, a frame (sometimes incomplete) is shown around a series that seems to have 
been acquired in exactly the same section as the reference series. 
 
This happens when the field of view and the section alignment are different or if a non-orthogonal 
cross-section was used. In this case the section plane is again slightly oblique, leading to this 
type of lines display. This may occur especially in manually planned MRI exams. 
 

 
Lines display with differences in viewport 

 
The application checks to see if the viewports (the field of view plus the section alignment) of 
the images are mostly identical (tolerance limit +/- 5 pixels). If the viewport is within this 
tolerance limit, no frame will be displayed. 
  



 

 

 
PD-730-154 iQ-LITE 3.1 Instructions for Use PUB INT EN – 001R 43 

 

 

 

 

 

 

 
 
 

 

NOTICE: 
For configuration of the scoutlines display (projection mode and line weight), see section 

4.2.18. 
 
 
4.2.5.6 Off 
 

 

The “Off” button turns off the side toolbar functions “Sync”, “Bind” and “Lines”. 

 
 
4.2.6 The menu bar 
 
The menu bar is divided into different sections: 
 

 
 
 File  
 Tools  
 Additional settings  
 Image filter  
 Image selection  
 Navigation  
 Help  
 
The main tools and functions listed in the menus are also available as toolbar buttons. However, 
since all tools are not available in the bottom toolbar, it may become necessary to use the 
respective menu item instead. Other functions are only accessible using the menus.  
 
The individual functions of menu items are described in the respective sections of these 
instructions for use. 
 

NOTICE: 
Some menu items are grayed out, as these functions are only available in the iQ-VIEW or iQ-
VIEW PRO software, but not in the iQ-LITE viewer. These functions will not be described in 

these instructions for use.  
 
 
4.2.7 Available mouse actions 
 
By default, it is recommended to work with a mouse with three buttons and a scroll-wheel. 
Specific functions are applied to each of the mouse buttons:  
 
 Left mouse button: Always provides the function that was selected in the bottom toolbar 

or menu. By default, it allows to scroll through the active series (stack mode).  
 Center mouse button: Pressing this button allows the user to change the center/window 

values of the currently active image. This windowing function is always available, even if a 
different function was selected from the toolbar/menu (e.g. measurements). 
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 Right mouse button: Opens different context menus, depending on the function currently 
selected in the toolbar. There is one default menu that provides access to the most often 
used tools. The “Zoom/pan” function, however, has its own context menu, which is shown as 
long as the “Zoom/pan” function is active (orange frame around the button). See section 
4.2.8 for details on the context menus. 

 Scroll-wheel: Using the scroll-wheel allows the user to browse through the active series. 
This option is available, even if the stack mode is not active. Thus, the user can quickly scroll 
to a different image in the series without leaving the active tool (e.g. a measurement tool). 
This browsing option is not available only in case that the “Scroll zoom” function is active. In 
that case, using the scroll-wheel will zoom in and out of the active image. 

 
While a configuration of the mouse buttons is not possible, there exist some options to speed up 
the access to specific functions: 
 
 A right-click opens a default context menu that provides quick access to the most important 

processing functions, such as the stack mode, the measurement tools and the windowing 
options. 

 A mouse with programmable function buttons can be used to define access to necessary 
processing functions. 

 
 
4.2.8 The right-click context menu 
 
For easy access to the most commonly used processing functions, iQ-LITE provides a context 
menu that is opened on right-click and is available through most of the active functions in the 
viewer. The following functions are accessible: 
 
 The “Stack mode” to browse through the active series 
 The “Distance” and “Circular ROI” tools as primary measurement tools; all other measure-

ment tools and options are also available through a sub-menu 
 All windowing options, from windowing presets to ROI window and auto-contrast to window-

ing reset 
 The option “Reset current view” that returns all images in the view to its original appearance 
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There is an exception to this context menu. When the “Zoom/pan” function is selected, a different 
context menu will be shown that is limited to the zooming options: 
 

 
 
As long as the “Zoom/pan” function is active, this menu will override the default context menu. 
To re-establish the default context menu, simply select a different function, such as stack mode, 
windowing or measurements. 
 
 
4.2.9 Mouse cursors for viewer actions 
 
Depending on the currently active processing tool the mouse cursor will change to indicate the 
respective function. These changed mouse cursor icons will be shown as long as the mouse is 
used within the image processing area. Outside the image processing area, the mouse cursor 
will return to the default Windows icon. 
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The following mouse cursors are possible: 
 

Active processing tool  Mouse cursor icon 

Stack mode 
 

Windowing 
 

Measurements (distance, angle, etc.) 
 

Clear (measurements/annotations) 
 

Modify (measurements/annotations) 
 

Magnifier 
 

Zoom 
 

Pan: this cursor consists of two parts (an open and a 
closed hand, for the gripping effect) 

 

 Pan (shown if left mouse button is released) 
 

 Pan (shown while image is being panned) 
 

 
The institution that creates the iQ-LITE medium has the option to set the size of the mouse 
cursor icons. Three sizes are available: small, medium and large. Default is small: 
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4.2.10 Closing the viewer and returning to the study browser 
 
4.2.10.1 Closing the viewer 
 
The viewer window can be closed in three different ways: 
 
 Click the “x” button in the upper right corner of the window. 
 Select the “Close viewer” button on the left side of the bottom toolbar. 
 Click the “File” menu and select “Close viewer”. 
 

 

“Close viewer”: Closes the viewer window and returns to the study browser (if placed 
on the same display).  
 

 
 
4.2.10.2 Bringing the study browser to the front 
 
To return to the study browser it is not necessary to close the viewer. Both applications run 
simultaneously and the study browser can be brought to the front without specifically closing 
the viewer.  
 
Use the option “Bring Study Browser to front” in the “File” menu. This moves the study browser 
from the background to the front and places the viewer into the background when both windows 
are placed on the same display.  
 

 
Each window also has its own task button in the Windows task bar. Click the respective button 
for the study browser to easily switch back to your study list. 
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4.2.11 Display settings 
 
The viewer application can be run on a single or dual display system.  
 

 
 
 
By default, the viewer opens only on one display. If two displays are available and they are 
connected to the computer, the viewer can be set up to view across both displays.  
 
To set up the viewer window in dual display mode, follow the instructions below: 
 
 Open iQ-LITE, select an arbitrary study from the study list and load it into the viewer to 

access the viewer window. 
 The viewer window opens on the primary display. 
 Go to the “Additional settings” menu, select “Display setup” and choose “Dual”. This activates 

the dual display mode. Depending on the monitor setup of the system and the current 
placement of the viewer window, the following can happen: 
- The viewer window is on the control display and two further high-resolution displays are 

connected. iQ-LITE detects the two displays with the same resolution. It suggests using 
these displays and also allows leaving the viewer window on the active screen. The user 
confirms his choice. 

- The viewer window is already located on one of the high-resolution displays. iQ-LITE 
automatically applies the dual display mode to the two high-resolution displays.  

- If only one display is available at the system or the connected displays have a different 
resolution, iQ-LITE will automatically apply the dual display mode to the screen on which 
the viewer window is currently located. This may be a solution for 2-in-1 displays. 

 
For individual settings and for other monitor configurations, the viewer window setup can be 
done manually.  
 

NOTICE: 
Since settings cannot be stored permanently on a medium, the dual display settings or any 

other window position and size will not be remembered the next time the application is started. 
The settings will only be used as long as the application is kept open. 
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Two studies loaded in a dual display setup 

 
NOTICES: 

1. Make sure to use the same kind of displays (same size, same resolution) for spreading the 
viewer, otherwise it will not be possible to correctly adjust the window across two screens with 

the center of the window remaining right between display one and two.  
2. When the dual display mode is used, the viewer window cannot be set into a maximized 

state. Otherwise it will be reduced again to one screen. 
 
 
4.2.12 The lightbox window 
 
In more and more imaging centers the traditional lightbox, where the radiologist is able to hang 
images on film, can no longer be found. However, there are still various instances where the 
radiologist is forced to look at images on film. This puts the radiologist in the position of needing 
a lightbox but not having one handy near his or her workstation.  
 
iQ-LITE offers the “Lightbox window” – a white screen that can be put anywhere on the available 
displays and can function as a replacement of the traditional lightbox. This way, the radiologist 
is able to more easily compare studies on film with those available as softcopy on the iQ-LITE 
viewer. 
 

 WARNING: 
Danger of misdiagnosis due to inappropriate image presentation. 

The lightbox window function offered in iQ-LITE does not correspond with a radiological film 
viewing box. It may, therefore, only be permitted for diagnostic use if all applicable legal  
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requirements regarding diagnostic film viewing in your country are met. Consult your 
authorized local distributor before using this function for diagnostic purposes. 

H.-No.: 1.1.9 
 
The lightbox function can be accessed by: 
 
 Clicking the option “Lightbox window” in the “Additional settings” menu. 
 Using the default shortcut [L].  
 

 
 

 
“Lightbox window” as full screen on second display 

 
While the lightbox window is open, the viewer is fully accessible and all image processing 
functions can be used. 
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The size and position of the window can be chosen freely:  
 
 Left-click into the white field to access the window status functions. 
 You can then set the window into full-screen mode, move it to another position on the 

display(s) (by clicking the title bar and dragging it with the mouse) and change the window 
size (by adjusting the window frame with the mouse). 

 

     
 
The size and position of the lightbox window will be remembered as long as iQ-LITE is not closed. 
For the next viewer session the lightbox window will return to its original size and position as 
settings cannot be stored on a CD/DVD. 
 
To close the lightbox window, use one of the following ways: 
 
 Right-click into the window. 
 Use the default shortcut [L]. 
 Use the [ESC] key (“Escape”). 
 Left-click into the window and then use the “x” button in the title bar. 
 
 
4.2.13 Treatment of single-frame images and multi-frame objects 
 
Single-frame image means that a physical file contains only one image. The most common image 
type would be a radiography image (CR or DX). Also CT and MR devices have, in the past, usually 
created a new file for every image that was acquired. In contrast, a multi-frame object is when 
one physical file contains a number of frames, i.e. an image sequence, similar to a movie. This 
is most common in ultrasound but is also used more and more often in multi-slice data, such as 
CT and MR. A series can, therefore, consist of many files with each presenting one image or of 
one or more multi-frame objects, where one object contains a sequence of images.  
 
For iQ-LITE, this does not matter. Multi-frame objects and single-frame images are treated 
equally. The stack and cine mode functions work for both; series of both object types can be 
shown in a sequence. It is also possible to display the individual frames of a multi-frame object 
in different tiles, to process them individually by using the image scope option, to select specific 
frames and to export or print them. 
 
The number stated in every series thumbnail of the series preview bar (see section 4.2.1) 
presents the number of individual images that are included in a series. It counts every single-
frame image and it counts every frame of a multi-frame object and shows the overall number of 
images in the thumbnail. 
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4.2.14 Navigating between images, series and studies 
 
The viewer offers a variety of ways to navigate between different images, series and studies 
loaded into the viewer. They can be accessed using the “Navigation” menu.  
 
For some navigation actions, default shortcuts are defined. Refer to chapter 6 for details. 
 
 
4.2.14.1 The “Navigation” menu 
 
The options in the “Navigation” menu may be used to navigate within a series, study or all 
studies loaded in the viewer. In addition, either the next or previous patient study from the 
current study list (in the study browser) can be loaded into the viewer. 
 

 
 
Navigation within a series:  
 
 “Next image”: Opens the next image of the series in the currently active view. 
 “Previous image”: Opens the previous image of the series in the currently active view. 
 “Next multi-frame object in series”: Is used for series consisting of several multi-frame 

objects. Instead of switching from one frame to the next, “next multi-frame object in series” 
will jump to the next object in the series, independent of the number of frames in the current 
object. If single-frame objects (= images) are included in the series, they will be considered 
an object as well. 
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 “Previous multi-frame object in series”: Is used for series consisting of several multi-frame 
objects. Instead of switching from one frame to the previous one, “previous multi-frame 
object in series” will jump to the previous object in the series, independent of the number of 
frames in the current object. If single-frame objects (= images) are included in the series, 
they will be considered an object as well. 

 “First image in series”: Opens the first image of a series in the currently active view. 
 “Last image in series”: Opens the last image of a series in the currently active view. 
 
Navigation within a study:  
 
 “Next series”: Opens the next series in a study in the currently active view. 
 “Previous series”: Opens the previous series in a study in the currently active view. 
 “First series in study”: Opens the first series in a study in the currently active view. 
 “Last series in study”: Opens the last series in a study in the currently active view. 
 
Navigation within studies:  
 
 “Next study”: Opens the next study in the currently active view (if more than one study is 

loaded into the viewer). 
 “Previous study”: Opens the previous study in the currently active view (if more than one 

study is loaded into the viewer). 
 “Next study in study list”: Loads the next study from the current study list (in the study 

browser) into the viewer. Current sorting are taken into account. 
 “Previous study in study list”: Loads the previous study from the current study list (in the 

study browser) into the viewer. Current sorting are taken into account. 
 
The hanging protocols navigation is disabled as the hanging protocols management is only 
included in iQ-VIEW PRO. 
 
Some of these navigation options are available as default viewer shortcuts (see chapter 6).  
 
 
4.2.15 Selecting individual series for viewing 
 
In the viewer, individual series can be selected from the thumbnails in the series preview bar. 
Either double-click a thumbnail to put the series into the currently active view (orange frame) 
or use drag and drop to transfer the series into an available view of the image processing area.  
 
 
4.2.16 Comparison of studies 
 
When more than one study is loaded into the viewer, a switch can be made between the available 
studies by clicking another study tab. The images from the new study will load into the image 
processing area.  
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If, however, comparisons are to be made between several series in different studies, it is 
necessary to keep the current series in the image processing area and only to add the desired 
series from another study.  
 
On a dual display setup, where the viewer is placed across both screens, the comparison of two 
studies is relatively simple, because the first two loaded studies will automatically populate the 
two screens for easy comparison. 
 
Where more than two studies are loaded or the viewer window is run in single display mode, the 
method to accomplish the comparison of series is a bit different.  
 
To add a series from a different study to the current layout of the image processing area, select 
the  sign in the series preview bar. On a single display, the preview bar of the second study 
will open. The desired series can be selected in the preview bar and dropped into an available 
view of the image processing area.  
 
If more than two studies are loaded, clicking the  sign will open a sub-menu with all other 
available studies. This happens both on single and dual display setups. The appropriate study 
can be selected from the list. The second series preview bar will show the series thumbnails of 
this additional study. The series needed can now be dragged into the appropriate view in the 
image processing area. Alternatively, double-clicking the series will load it into the currently 
active view.  
 
These are easy ways to manage the comparison of studies.  
 
As an example, to compare two studies in a 2x1 mode on a single display, use the screen tiling 
function located either in the bottom toolbar or in the “Tools” menu and select the option 2x1 
on series level (also see section 4.2.3.2). The views in the image processing area will display 
the first study. Place the series to compare into the left view. To add the second study to the 
right view, open the second series preview bar by using the  button in the series preview bar 
and select the correct study (if more than one is available). This will display the series thumbnails 
of the second study but does not change the display in the image processing area. Now drag 
and drop the desired series into the right view. 
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Left study loaded in 2x1 tiling and sub-menu with further available studies 

 

 
Second study loaded into the right view of 2x1 tiling for comparison 
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4.2.17 Selecting images, series and studies for printing and export 
 
When images, series or studies are to be exported to another image format (e.g. JPEG, BMP or 
TIFF), a video file (AVI) or to be printed on a Windows printer, it is sometimes necessary to first 
mark these images for export. This is the case when only a selection of images is supposed to 
be exported, e.g.: 
 
 Only specific images (either from one or several series) 
 Several, but not all, series of a study 
 Data from different studies  
 

 
Individual images can be marked or unmarked by clicking the box in the upper right 
corner of each view. When an image is marked, the box will turn red with a check-
mark.  

 
To easily select a sub-volume of a specific series, use the [SHIFT] key. Select the first image of 
the volume you wish to mark by marking the checkbox. Then scroll down or up to the last image 
of the volume, hold the [SHIFT] key pressed and click the checkbox. All images from the first to 
the last are now marked. Unselecting images works the same way.  
 

NOTICE: 
The selection of a sub-volume by using the [SHIFT] key can be used to easily eliminate scout 

or localizer images from a series before exporting them. 
 
Further selection options are available in the “Image selection” menu: 
 

 
 

 
 
Using the “Image selection” menu it is possible to mark images on a series or study level. Options 
include: 
 
 Select a whole study or series 
 Select every second image of a study or series 
 Select every third image of a study or series 
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 Select every fourth image of a study or series  
 
It is further possible to mark the currently active image (“Select active image”) and to “Clear 
current selection” to reset all selections.  
 
 
4.2.18 Orientation tools 
 
Especially in multi-slice studies, such as CT or MR exams, orientation within the different section 
planes can be difficult. This is where orientation tools such as scoutpilots and lines displays can 
be helpful. iQ-LITE offers several orientation tools to aid the users. 
 
 
4.2.18.1 “Lines” mode 
 
The “Lines” mode in the side bar (hidden on the left side of the screen) is essentially a scoutpilot 
function that simplifies the orientation in a study by displaying the position of the current slice 
(active frame) within the other series and section planes. It is particularly helpful in multi-slice 
studies taken from different section planes. The “Lines” mode can be activated easily without 
having additional windows open which may impede the view in the image processing area. 
 

NOTICE: 
For further details, refer to section 4.2.5.5. 

 
 
4.2.18.2 Scoutpilot 
 
The scoutpilot tool provides the user with positional information about images. This function 
allows users to orient themselves within a series. 
 
The “Scoutpilot” function is found in the “Tools” menu.  
 

 
Scoutpilot example 
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The scoutpilot window can be moved to another position so that it does not hide the necessary 
views of the image processing area. Simply drag and drop the window to the desired position. 
The size of this window, however, is fixed. 
 
When opened, the scoutpilot always shows the currently active image (orange frame). 
 
The image in the scoutpilot can be manipulated in the following ways: 
 
 Using the center mouse-button (or scroll wheel), it is possible to change the window level. 
 By pointing to the border of the image (the zoom zone), the mouse pointer turns into a 

magnifier and allows zooming within the image. While the mouse is a magnifier, hold the left 
mouse button down and move the mouse up and down to zoom in and out, respectively. 

 While pointing in the center of the image (the pan zone), the mouse pointer turns into a 
hand. Hold the left mouse button down and move the mouse to pan the image. 

 
 “Refresh”: This button can be used to reset windowing, zoom and pan changes made in 

the image or to select a new image as the reference image.  
 
To select a new image as the reference image, start by scrolling the view in the image 
processing area down to the image you want to use as reference. It must be the active 
image (orange frame). Then, click the scoutpilot’s refresh button to update the reference 
image.  

 
 “Close”: Closes the scoutpilot window. 

 
 
4.2.18.3 Scoutlines configuration 
 
By default, iQ-LITE projects the section planes in its “Lines” and “Scoutpilot” display, leading to 
the display of rectangles or parallelograms – if the section planes are oblique. It is also possible 
to modify the display settings by: 
 
 Adapting the projection mode 
 Adapting the line weight 
 
The “Scoutlines configuration” is found in the “Additional settings” menu.  
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Different projection modes are available for both the “Lines” mode and the “Scoutpilot” window: 
 
 “Mode: plane projection”: This is the default setting. If activated, the scoutlines functions will 

display only the projection of the section planes. 
 “Mode: plane intersection”: If activated, the scoutlines functions will display only the lines 

where the section planes cut (intersect) each other. 
 “Mode: plane projection and intersection”: If activated, the scoutlines functions will display 

both the projection of the section planes and the intersection lines. 
 
The line weight may be changed to adapt to a higher or lower display resolution. For high-
resolution displays it may be more comfortable to use bolder lines. The following options are 
available: 
 
 Line weight 1 (light) 
 Line weight 2 (medium); this is the default setting. 
 Line weight 3 (strong) 
 Line weight 4 (bold) 
 

NOTICE: 
The user-defined settings are only available for the current iQ-LITE session. Since settings 

cannot be stored permanently on a medium, any settings changed from the default will not be 
remembered for the next start of the application. Thus, it may be necessary to configure the 

scoutlines display again. 
 
 
4.2.19 Presentation states in iQ-LITE 
 
Presentation states (PR) are independent DICOM SOP instances containing information on how 
a particular image should be displayed. The presentation state may contain, for instance, 
windowing, zooming and panning values, information about rotation or flipping and other visual 
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display elements defined in the DICOM standard. What presentation states do not contain is 
pixel data. Therefore, PR can only be used in combination with an existing DICOM image.  
 
When a presentation state is applied to an image, the image is then displayed with all the visual 
specifications defined in that presentation state. The advantage of using presentation states is 
that it is always possible to revert back to the original image since the underlying pixel data of 
the image is not modified, but rather displayed differently.  
 
 
4.2.19.1 Use of presentation states in iQ-LITE 
 
It is important to note that iQ-VIEW/PRO – which is the basis for the iQ-LITE viewer – only 
supports its own presentation states (PR). While images retrieved from other DICOM stations 
may already contain presentation states, iQ-VIEW/PRO will not be able to make use of these 
presentation states.  
 
As a result, iQ-LITE media created with the radiological workstation can only contain PR files 
that have been created and stored with an iQ-VIEW PRO station. Presentation states of other 
manufacturers will be ignored during the export and will therefore not be placed on the medium.  
 
PR created for studies within iQ-VIEW PRO will be correctly used within iQ-LITE.  
 
In iQ-LITE, all modifications made to an image during its processing in the viewer (e.g. window 
level changes, zooming/panning, flipping/ rotating and adding of measurements and annota-
tions) will generally be treated as a presentation state. This makes it possible to switch between 
different series or studies in the viewer without losing the changes, to transfer images including 
these modifications to printers or to export them to other file formats.  
 
They will, however, only be cached for the current viewer session. They are discarded when the 
viewer session is ended and the viewer is closed. When the same study is reloaded into the 
viewer afterwards, the images will be displayed again with their original pixel data. 
 
 
4.2.19.2 Clearing presentation states 
 
It is possible to remove changes made to an image (e.g. windowing, zoom/pan, flip/rotate, etc.). 
These temporarily cached presentation states can be deleted using the “Reset” button in the 
bottom toolbar or by choosing “Reset current view” in the “Tools” menu. Alternatively, “Clear 
presentation states” in the “Tools” menu can also be used.  
 
A reset will also delete measurements and annotations made in the images. Additionally, these 
can be deleted manually or by using the “Tools” menu. For more details on the treatment of 
measurements, see section 4.2.24. 
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4.2.20 Overlays and look-up tables 
 

 
 
 
4.2.20.1 Text overlay 
 
The text overlay provides patient, study and series information necessary to identify images 
displayed in the image processing area. It is activated by default when images are loaded into 
the viewer. This is done to insure that important information, such as lossy image compression 
or potential mix of different patients, is always recognized by the user. 
 
The text overlay can be activated and deactivated both from the button in the bottom toolbar 
and from the “Text overlay” entry in the “Tools” menu.  
 

 

“Text overlay”: Is used to hide the text overlay information that is activated by 
default. Clicking this button will toggle between activating and deactivating the text 
overlay. 

 

 
Text overlay sample for an MR series 
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4.2.20.2 Display of lossy image compression 
 
If an image displayed in the image processing area has been lossy compressed, this information 
will be shown in the text overlay, provided that the necessary details were correctly stored in 
the image information. Compression information will only display if the text overlay is activated.  
 

 
 
Complete compression information of an image is shown in the DICOM header dump. See also 
section 4.2.32 for more information. 
 

 
 

 WARNING:  
Danger of misdiagnosis due to the use of lossy image compression. 

Excessive compression levels may cause compression artifacts that might reduce the image 
quality to non-diagnostic level. These images may therefore no longer be usable for diagnostic 

purposes! 
When reading medical image data, it is important to know if compression has been used. 

Always check the viewer display for the “Lossy compression” marker and, if necessary, use the 
DICOM header data to determine the degree of compression.  

The user’s organization should make sure to use lossy compression only according to local 
regulatory requirements. 

H.-No.: 1.1.5, 1.1.9 
 

 WARNING 
For users under the jurisdiction of the U.S. Food and Drug Administration (FDA) 

Danger of misdiagnosis due to lossy image compression in mammography. 
Currently the FDA does not permit images regenerated from lossy compressed data to be used 

in the same manner as the original mammogram. As a consequence, lossy compressed 
mammography images must neither be reviewed for primary diagnosis or final image 

interpretation nor be stored for retention purposes. 
Only use original (uncompressed) or lossless compressed images for diagnostic purposes to 

ensure that the images are displayed and processed in FDA approved diagnostic quality. 
H.-No.: 1.1.9 

 
 
4.2.20.3 Display of warning in case of potential patient mix 
 
Although it is less likely for a patient medium to contain image data from different patients, 
there is still a minor chance that not all studies on the medium actually belong to the same 
patient. Especially in case of inconsistent patient information, typos in the patient name or 
accidental assignment of the same patient ID to different patients, it is possible that a patient 
medium may also contain studies of a different patient than expected. 
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To help you discover potential patient mixes, iQ-LITE will show a “Potential patient mix!” warning 
in the text overlay in the viewer’s image processing area, in case studies with differing patient 
information are loaded into the viewer. 
 

 
 
The first study (first study tab) functions as reference study. Additionally loaded studies, where 
the patient name, the date of birth and/or the patient’s sex are different, will be marked with 
the warning. 
 

 WARNING:  
Danger of misdiagnosis due to potential patient mix. 

Even on patient media, there is still a slight risk that not all studies or images in a study 
belong to the same patient and that diagnostic findings are accidentally assigned to the wrong 

patient.  
Always check the viewer display for the “Potential patient mix!” warning and refer to the 

patient information stated on the study tab and in the text overlay in order to determine which 
patient the read study belongs to.  

Keep the text overlay activated to ensure that you are warned accordingly. 
Also be aware of the remote risk that two different patients with identical name, date of birth 
and sex may have existed in the archive of the institution that created this patient medium 

and that accidentally studies from both patients may have been stored on the medium. As the 
patient ID is not compared (because different IDs for the same patient are allowed and not 

uncommon), studies from different patients with identical demographics would not be marked 
with the “Potential patient mix!” warning. 

H.-No.: 1.1.6 
 
 
4.2.20.4 Bitmap overlay 
 
Sometimes, additional information is burned into original images as a so-called bitmap overlay. 
This can, for instance, be localizer information, orientation markers or also other annotations. 
By default, “Bitmap overlay” display is enabled. If activated, a potential bitmap overlay in an 
image is displayed. If the bitmap overlay is not needed, simply deactivate this function. It 
functions independently from the text overlay.  
 
This function can only be accessed by clicking “Bitmap overlay” in the “Tools” menu. 
 

    
Examples of bitmap overlays 
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4.2.20.5 Look-up tables 
 
iQ-LITE is able to interpret potentially embedded look-up tables in order to display a DICOM 
image the way it is displayed on the source machine. By default, “Look-up tables” display is 
enabled. 
 
This function can only be accessed by clicking “Look-up tables” in the “Tools” menu. 
 

  
Image with and without enabled look-up table 

 
 
4.2.20.6 DICOM-embedded shutters 
 
A shutter is a kind of mask used to hide specific parts of an image that are irrelevant for its 
interpretation. As such they reduce distraction when reading such an image. 
 
Shutters created with the viewer’s shutter tool are handled as presentation states. However, 
shutters can also be embedded within the DICOM header of an image and are, therefore, handled 
differently. This may be the case with shutters created in images in the iQ-VIEW/PRO “Import” 
dialog or with images to which shutters were already applied at the source modality. 
 
By default, “Embedded shutters” display is enabled. As a result, iQ-LITE is able to interpret 
potentially embedded shutter sequences in order to hide a specific part of a DICOM image. If 
the function is disabled, the entire image will become visible again.  
 
This function can only be accessed by clicking “Embedded shutters” in the “Tools” menu. 
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Image with and without enabled embedded shutter 

 
 
4.2.21 Cine and stack mode 
 
Stack and cine mode make it possible to manually or automatically browse through all images 
of a series (or even the complete study when used in combination with the “Bind” mode; see 
section 4.2.5.3). 
 
Both the stack and the cine modes are available by using the respective toolbar button in the 
bottom toolbar or the “Stack mode” and “Cine mode” entries in the “Tools” menu. 
 

 
 
When the stack function is activated using the toolbar button or the menu item, the shape of 
the mouse pointer will change to indicate the use of stacking through a series of images. See 
section 4.2.9. 
 
 
4.2.21.1 Stack mode 
 

 

The stack mode is always activated by default and can be used even if other 
processing functions are activated. Browsing through images with the stack mode is 
possible in different ways. 

 
With the following options, one image after another of the series will be displayed, which is useful 
when wanting to browse all the images of the series: 
 
 Use the mouse scroll-wheel to move through a series. This function is not available if “scroll 

zoom” is activated. 
 Use the up and down arrow keys on the keyboard to scroll to the next or previous images. 
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With the following options, images of the series will be skipped to move faster from one position 
in the series to another. This can be useful if you wish to go to a particular area quickly: 
 
 Select the “Cine mode (stack)” button in the tool bar or the “Stack mode” function in the 

“Tools” menu. Then move the mouse up and down while keeping the left mouse button 
pressed to browse through a series. 

 Use the scrollbar to the right of every view to scroll through a series of images by pulling the 
controller up and down.  

 
 WARNING: 

Danger of wrong or incomplete diagnosis. 
Skipping images by using the respective browsing functions stated above could lead to missing 
diagnostically relevant images. Use these functions carefully and always browse all images to 

provide best diagnostic results.  
H.-No.: 1.1.5 

 
For more navigation options see section 4.2.14. 
 
 
4.2.21.2 Cine mode 
 

 

With DICOM multi-frame objects (e.g. angiographic or ultrasound images) as well as 
single-frame, multi-slice series (e.g. CT, MR), a series can be run automatically as a 
sequence. Either right-click the “Cine mode” button in the bottom toolbar or select 
“Cine mode” from the “Tools” menu to access the cine mode sub-menu. 

 
NOTICE: 

In combination with the “Bind” mode it is also possible to automatically browse through an 
entire study within one view. 

 
 “Start autoplay”: Cine mode will begin playing automatically. A separate cine mode player 

(cine control) opens to control the cine playing. 
 

 “Pause autoplay”: The pause button temporarily suspends the cine play. A second click 
restarts the cine play from where it was paused. 

 
 “Stop autoplay”: The stop button stops the cine play and closes the cine control. 

 

 
 

NOTICE: 
iQ-LITE can display up to 50 frames per second. The actual speed that can be reached when 

displaying images in a cine loop depends on the system resources. If the “Frm/s” display turns 
red, the requested speed cannot be reached due to system limitations. A limited text overlay 

will be shown during the cine run to save resources. 



 

 

 
PD-730-154 iQ-LITE 3.1 Instructions for Use PUB INT EN – 001R 67 

 

 

 

 

 

 

 
 
 

 

 
The “Cine control” can be moved to a different part of the screen by clicking anywhere in the 
gray area of the control and dragging it to another position.  
 
Further settings: 
 
 “Direction”: The cine can either be played “Forwards” or “Backwards”. Select the respective 

entry from the sub-menu or move the controller in the cine control either to the right 
(including the correct frame rate) for forwards playing or to the left (including the correct 
frame rate) for backwards playing. 

 “Frame rate”: Using the entry in the cine mode sub-menu several pre-defined frame rates 
can be selected for the cine run (6, 12, 24, 32 fps = frames per second).  The default frame 
rate is defined in the DICOM header for multi-frame objects or is 25 fps for single-frame 
images.  

 
The direction and the frame rate can also be adjusted in the cine control itself by moving the 
indicator bar while the cine is running. 
 
 
4.2.22 Windowing tools 
 
In many cases, the brightness and contrast for the images are already well-set when the images 
are created at the modalities. In other cases, special look-up tables are already added in the 
post-processing of the images, thus optimizing the image visualization. Sometimes, however, it 
might be necessary to change the window level of images when reading them within iQ-LITE, 
e.g. when the series is too dark or the contrast is not good enough to see specific tissues. 
 
iQ-LITE offers different ways of changing the center/window level of images: 
 
 Dynamic windowing 
 The use of window presets 
 Windowing of a specific region of interest  
 Auto-contrast 
 
 
4.2.22.1 Applying window changes 
 
Using the “Scope” function, described in section 4.2.5.4, it is possible to apply window changes 
to a whole series or to an individual image only: 
 
 Select “Image scope” to only change the center/window values of a particular image. 
 Select “Series scope” to apply windowing changes made in one image to all images of the 

same series. 
 

NOTICE: 
Window changes made will be reset when the scope is changed (from series to image or from 
image to series). Windowing can then be applied again according to the newly selected scope. 
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When the windowing function is activated using the toolbar button or the menu item, the shape 
of the mouse pointer will change to indicate the use of windowing. See section 4.2.9. 
 
Changes in window/level can be reset by using the “Reset windowing” option in the windowing 
sub-menu. This will keep all other modifications made in the images (e.g. measurements) in 
contrast to using the general “Reset” button. 
 
 
4.2.22.2 Dynamic windowing 
 
Dynamic windowing is the default form of window leveling in iQ-LITE. When doing windowing 
within a series, dynamic windowing calculates the changes in the center/window values, based 
on the original center/window values as they are stated in the DICOM information of each image. 
As a consequence, all images of a particular series may have different center/window values. 
This most often occurs in MR series where the contrast and brightness vary from image to image.  
 
Example: One image has original W/C values of 700/300 and a second has original values of 
730/310.  If the window value of the first image is increased by 15 and the center value is 
decreased by 15 (new: 715/285), then the values of the second image will also be increased 
(window) and decreased (center) by 15 (new: 745/295). 
 

 

In iQ-LITE, the dynamic windowing is active by default. The function can easily be 
accessed in different ways: 
 
 While pointing to an image, click the center mouse-button (scroll-wheel) and 

move the mouse up/down and left/right. This option is also available if other tools 
are currently selected. 

 Select the “Windowing (dynamic)” button in the bottom toolbar. While pointing 
to the image, click the left mouse button and move the mouse up/down and 
left/right. 

 Click the “Tools” menu and select “Windowing.” While pointing to the image, click 
the left mouse button and move the mouse up/down and left/right. 

 
 
4.2.22.3 Using window presets 
 
Another possible form of applying center/window changes to images is to use pre-defined 
window presets.  
 
The iQ-VIEW/PRO radiological workstation comes with a number of window presets. Users can 
also define their own and add them to the presets list. The configuration file in which these 
presets are stored is also copied to the medium during its creation. As a result, any presets 
established in iQ-VIEW/PRO are also available for use in iQ-LITE.  
 
The window presets pop-up menu can be accessed by right-clicking the “Windowing (dynamic)” 
button in the bottom toolbar or by selecting “Window presets” in the “Tools” menu: 
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Several standard window settings (presets) may be selected: 
 
 Brain 
 Skull 

 Lung 
 Mediastinum 

 Abdomen 
 Bones 

 
Additional or customized settings may be available if the iQ-VIEW/PRO user has created other 
settings not initially included in the default list. 
 

NOTICE: 
The window presets can also be used in combination with tiling on the image level (several 

images in one view). This is possible with scope on series and image levels as well. 
 
 
4.2.22.4 Changing the window/level in a specific region of interest (ROI) 
 
ROI windowing is mostly used for CR and RF images to generate an optimal contrast in a 
particular region.  
 
This function applies an auto contrast to a whole image based on a region selected within that 
image, i.e. a region of interest (ROI). It can enhance the visibility of any structure obscured in 
the contrast usually calculated for the entire image, such as the retrocardial spine, the 
retrocardial lung or the lung apex.  
 
Select the option “ROI window” and then mark the area of interest by drawing a rectangle onto 
the image with the mouse. The ROI window will then be calculated automatically on the basis of 
the selection. 
 



 

 

 
PD-730-154 iQ-LITE 3.1 Instructions for Use PUB INT EN – 001R 70 

 

 

 

 

 

 

 
 
 

 

   
Performing ROI windowing 

 
 
4.2.22.5 Applying an automatic contrast 
 
The option “Auto contrast” applies an automatic contrast to the current image (with “Image 
scope”) or to a whole series (with “Series scope”) only. All other series remain unaffected.  
 
Additionally, there is an auto-contrast function available for applying an automatic contrast to 
all loaded studies. Once applied, the auto-contrast will remain in effect until being deactivated 
again.  
 
 Click the “Additional settings” menu 
 Select “Auto-contrast every image” 
 All images of the currently selected study will be displayed with an automatically calculated 

contrast.  
 

 
 

NOTICE: 
In case images are loaded into the image processing area that do not contain any pre-defined 
center/window values or look-up tables, iQ-LITE will automatically apply an automatic contrast 

to be able to present the images. 
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4.2.23 Color remapping 
 
Color remapping assigns a color to each gray tone of an image, therefore rendering any grayscale 
image (MONOCHROME1 and MONOCHROME2) in color. Using colors, areas with low contrast can 
be better displayed. Color remapping is particularly useful in nuclear medicine and it is for this 
reason that iQ-LITE also provides a number of nuclear medical color schemes. 
 
Using the “Scope” function, described in section 4.2.5.4, it is possible to apply color schemes 
either to a whole series or to an individual image only: 
 
 Select “Image scope” to apply a color scheme only to a particular image. 
 Select “Series scope” to apply a color scheme to all images of the same series. 
 

NOTICE: 
Color remapping will be reset when the scope is changed (from series to image or from image 
to series). The modifications can then be applied again according to the newly selected scope. 

 
Color remapping options can be accessed in one of the following ways:  
 
 Select the “Color scheme” button in the bottom toolbar 
 Click the “Tools” menu and select “color scheme” 
 

 

“Color scheme” offers several general options: normal grayscale output (“B/w”), 
inverted grayscale output (“B/w negative”), color remapping (“Color remap”) and 
inverted color remapping (“Negative color remap”). In addition, these nuclear color 
schemes are available:  

 
 Hotiron 
 Rainramp 
 GE_Color 

 Gold 
 NIH 
 NIH_Ice 

 Bone 
 Cardiac 
 Spektrum 

 Blackbody 

 

    
Examples for color remapping 

 
 
4.2.24 Measurement and annotation tools 
 
iQ-LITE offers a variety of measurement and annotation tools that make it possible to easily 
evaluate tissue and bone structures and to add evidence markings to images (distances, angles, 
ROI, etc.). These tools are available both as toolbar button and menu entries.  
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Some of the measurement tools and processing options are exclusively available in iQ-VIEW or 
even only iQ-VIEW PRO and can, therefore, not be accessed with iQ-LITE. These tools are marked 
accordingly in the following sections. 
 
The measurement and annotation tools can be accessed in the following ways: 
 
 Click the “Tools” menu and select “Measurement tools” to access the sub-menu displaying all 

functions. 
 Select the “Measurement tools” button on the bottom toolbar. A right-click on the button 

opens a sub-menu, where all available measurement and annotation functions can be found.  
 

 
 

NOTICE:  
Measurements and annotations can be applied to rotated and mirrored images. Only images 
with square and circular ROI measurements or hip dysplasia angles that were rotated at a 

custom angle are excluded. If ROI measurements are made in an image before it is rotated, 
these measurements will no longer be visible after the rotation. However, the measurements 
will not be deleted and will become visible again when the image is rotated using a standard 

rotation. The same behavior applies to drawn shutters. 
ROI measurements are also not possible in color images (e.g. RGB) because the density relies 

on the grayscale values, which are absent in such image material. 
 
 



 

 

 
PD-730-154 iQ-LITE 3.1 Instructions for Use PUB INT EN – 001R 73 

 

 

 

 

 

 

 
 
 

 

4.2.24.1 Calibrated measurements vs. measuring at detector plane  
 
There are different ways to provide information about the size of an image. While generally 
image dimensions would be given in pixels (for width and height), this does not help the 
radiologist to evaluate the size of tissues/structures. Therefore, the images usually contain 
information about how large a pixel is. 
 
This pixel information depends on the type of image. 
 
In radiography images (CR, DX, RF, XA etc.) where the anatomy is projected onto an imaging 
plate and is, therefore, enlarged, the pixel size refers to the size at the detector. In order to do 
correct distance measurements, it is necessary to calibrate the images first. The appropriate 
attribute to indicate the dimensions of an image in this case is ImagerPixelSpacing (0018,1164). 
 
For cross-sectional images as created by CT and MR devices, the pixel size is already calibrated. 
Distance measurements, therefore, already represent the actual size of the anatomy. No further 
calibration is necessary. The appropriate attribute to indicate the dimensions of an image in this 
case is PixelSpacing (0028,0030). 
 

NOTICE: 
In ultrasound images a completely different type of pixel size calculation is used resulting from 

the specifics of the ultrasound technique. This type is called region calibration. See section 
4.2.24.2 for details on the handling of measurements in US images. 

 
iQ-LITE will check for both attributes and will behave as follows based on what information it 
can find in the image: 
 
 If only attribute PixelSpacing (0028,0030) is available, it will be used. 
 If only attribute ImagerPixelSpacing (0018,1164) is available, it will be used. 
 If both attributes are available, the application will compare the values.  

- If both are exactly the same (i.e. no rounded values), the attribute ImagerPixelSpacing 
(0018,1164) will be used.  

- If the values are different, the application will assume that image calibration was done 
and use attribute PixelSpacing (0028,0030). 

 
You are informed via text overlay, which parameter is used as a basis for measurements: 
 
 If the measurements are based on the PixelSpacing attribute, the overlay will read: 

“Measured size is calibrated”. 
 If the measurements are based on the ImagerPixelSpacing attribute, the overlay will read: 

“Measured size is at detector”. 
 

 WARNING: 
Danger of misdiagnosis due to incorrect measurements. 

Some manufacturers misleadingly use the attribute PixelSpacing (0028,0030) in radiography 
images, suggesting that the pixel size is already calibrated even though no calibration has 

taken place. If the value does not correspond exactly with the value stated for the pixel size at 
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the detector (ImagerPixelSpacing), iQ-LITE assumes a calibration and will show the 
information “Measured size is calibrated”. 

Do not make any assumptions on whether this could really be true. Only do measurements on 
projection radiographs by comparison against the calibration object of known size that is 

burned into the image. See section 4.2.24.20 for details on calibration within iQ-LITE. 
H.-No.: 1.3.1 

 
NOTICE: 

The attribute NominalScannedPixelSpacing (0018,2010) as it may be used in scanned films 
stored as secondary capture images in order to indicate pixel size is currently not supported. 

 
 
4.2.24.2 Particularities of distance measurements in ultrasound images 
 
In ultrasound images an overall pixel spacing information is difficult, although it can exist. 
Usually, specific regions within the image are defined that have specific dimensions, where other 
regions of the image have different dimensions. That makes measuring within these images 
difficult. 
 
Usually, measurements in US images are already done during the procedure at the ultrasound 
device itself and not so often at post-processing workstations. Due to this, the iQ-LITE support 
of US region calibration is limited to distance measurements only. 
 
iQ-LITE will handle distance measurements within ultrasound images as follows: 
 
 Whenever a measurement tool is active, iQ-LITE will visually indicate all regions with distance 

units (where the result can be given in mm). In all other regions, a distance measurement 
will lead to a measurement value given in pxl. An overall pixel spacing will not be marked. 

 

 
US image with two visualized regions 

 
 Distance measurements within one defined region are possible (start and end points are in 

the same region). This is also true if the distance line crosses another region. In either case, 
the result is given in mm. See lines A and B below. 
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 Distance measurements across two or more different regions are not possible (start and end 

points are in different regions). The result is given in pxl. See line C below. 
 

 
 
 Distance measurements from one defined region into a non-defined area (also no 

PixelSpacing defined) or vice versa are possible. The pixel spacing of the defined region is 
used as basis. The result is given in mm. See line D below. 
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In images with US Region Calibration it makes no sense to show the ruler, which can usually be 
found on the right side of every view, because the user will not know to which region the ruler 
applies. This could lead to misjudgments.  
 
 
4.2.24.3 Distance measurements 
 

 

“Distance”: The distance tool is used to measure a distance. To use the tool, point 
to the position where the measurement should begin and hold the left mouse button 
down while dragging the mouse to the end point. Releasing the mouse button will 
finish the distance line and show the results in millimeters. 

 
During the drawing of the distance line, the current measurement value is displayed and 
constantly updated. In addition, a center marker is displayed in every distance line, indicating 
half of the measured distance. 
 

NOTICE: 
If the result is not given in millimeters but in pixels (pxl), the pixel spacing information is 

missing in the affected image, or, in case of ultrasound images, no distance-related regions 
are defined, the region calibration information is missing or incomplete or the distance 

measurement was drawn across different regions. The pixel spacing or region calibration 
values are needed by iQ-LITE to know how big a pixel is in the image. This information is 

needed to calculate a distance. See section 4.2.24.2 for details regarding distance 
measurements in ultrasound images. 

 
 
4.2.24.4 Ratio measurements 
 

 

“Ratio”: The ratio tool is used to measure a ratio between two distances. To use the 
tool, draw the first distance (A) and then the second (B). The result is given as a 
percent (%) of A/B. The length of the two distances is also shown. 
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NOTICE: 
If the length of the lines is not given in millimeters but in pixels (pxl), the pixel spacing 

information is missing in the affected image, or, in case of ultrasound images, no distance-
related regions are defined, the region calibration information is missing or incomplete or the 

distance measurement was drawn across different regions.   The pixel spacing or region 
calibration values are needed by iQ-LITE to know how big a pixel is in the image. This 

information is needed to calculate the length of the two lines. See section 4.2.24.2 for details 
regarding distance measurements in ultrasound images. 

 
 
4.2.24.5 Perpendicular distance measurements 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Point-to-line distance”: The point-to-line distance tool is used to measure the 
distance between a defined point and a drawn line in an orthogonal angle. This tool 
can be used, for example, for evaluating a spinal rotation scoliosis. 

 
 
4.2.24.6 Point-to-line distance measurements 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Point-to-line distance”: The point-to-line distance tool is used to measure the 
distance between a defined point and a drawn line in an orthogonal angle. This tool 
can be used, for example, for evaluating a spinal rotation scoliosis. 

 
 
4.2.24.7 Angle measurements 
 

 

“Angle”: The angle tool is used to measure an angle. To measure angles, draw the 
first line as if drawing a distance measuring line. The second line does not necessarily 
have to intersect the first line. The resulting measurement values represent the acute 
and obtuse angle. 

 
As soon as the second ray of the angle measurement is started, iQ-LITE displays the current 
measurement value. While the line is drawn the value is constantly updated.  
 
 
4.2.24.8 Cobb’s angle measurements 
 
Cobb’s angle is a method of measuring the degree angle of the spinal curve. The technique to 
measure the scoliosis curve consists of four lines constructing a geometric figure. 
 

 

“Cobb’s angle”: To use this tool, first draw a line along the superior edge of the 
vertebra and extend the line into the margin of the X-ray (line A). iQ-LITE will 
automatically add the perpendicular line from line A downward. The next step is to 
draw another line along the inferior vertebra. Again extend it into the margin of the 
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X-ray (line B) until the perpendicular line upwards from line B meets the one from 
line A. The angle that is formed by the two meeting perpendicular lines is the Cobb’s 
angle. 

 

 
Cobb’s angle measurement 

 
 
4.2.24.9 Interior angle measurements 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Interior angle”: The interior angle tool is used to measure an interior angle in a 
right-angled triangle, i.e. an acute angle adjacent to the hypotenuse. This tool can, 
for example, be used for the measurement of joint angles of the wrist.  

 
 
4.2.24.10 Hip dysplasia angle measurements 
 

 

“Hip dysplasia angle”: This tool is a means of assessing hip laxity and is used in the 
detection of hip dysplasia. The result of such a measurement is the angle formed by 
a line connecting the centers of both femoral heads and one drawn between the 
center of a femoral head and the craniodorsal rim of the acetabulum on the same 
side. 

 
Such an angle measurement consists of a more complex geometric figure. iQ-LITE therefore 
provides a measurement template that only needs to be adapted to the image. First select the 
“Hip dysplasia angle” tool and then click into the femoral head on the right of the image. A 
template will be displayed and iQ-LITE will automatically switch into the “Modify” mode so that 
you can adjust the circles and angles as you need. 
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Hip dysplasia angle measurement (left = template; right with adjustments) 

 
 
4.2.24.11 Square ROI measurements 
 

 

“Square ROI”: With the square ROI tool it is possible to measure the density in a 
selected rectangular area (ROI). To use this tool, place the mouse at one corner of 
the area that shall be measured, hold the left mouse button down and drag the 
mouse diagonally until the appropriate area is selected. When the mouse button is 
released, a rectangle will be drawn over the specified area and the mean, maximum 
and minimum density values will be given (in decimal values; displayed unit is “INT”). 
For CT images the results are displayed in Hounsfield Units (HU). In addition, the 
results will state the standard deviation. 

 
NOTICE: 

Density measurements in regions of interest (ROI) are not possible in color images (e.g. RGB) 
because the density relies on the grayscale values, which are absent in such image material. 

 
 
4.2.24.12 Circular ROI measurements 
 

 

“Circular ROI”: Measuring density in a selected elliptical/circular area (ROI) is 
possible using the circular ROI tool. To use this tool, place the mouse in the center 
of the area that shall be selected, hold the left mouse button down and drag the 
mouse outward from the center to create an ellipse/circle around the desired area. 
When the mouse button is released, the mean, maximum and minimum density 
values will be given (in decimal values; displayed unit is “INT”). For CT images the 
results are automatically displayed in Hounsfield Units (HU). In addition, the results 
will state the standard deviation. 

 
NOTICE:  

A perfect circle (not an ellipse) can be achieved by holding the [SHIFT] key while drawing the 
ROI area with the mouse. 

 
NOTICE: 

Density measurements in regions of interest (ROI) are not possible in color images (e.g. RGB) 
because the density relies on the grayscale values, which are absent in such image material. 
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4.2.24.13 Polygonal ROI measurements 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Polygonal ROI”: Using the polygonal ROI tool, it is possible to measure both the 
density and size of a selected freehand area. 

 
 
4.2.24.14 Shutters 
 

 

“Shutter”: The shutter tool makes it possible to select a specific rectangular area of 
an image while blackening out the rest of the image. The blackened-out areas are 
not deleted from the image.  They are only hidden. To use this tool, place the mouse 
in one corner of the area to view, hold the left mouse button down and drag 
diagonally until the appropriate area is selected. When the mouse button is released, 
only the selected area will be visible. 

 
NOTICE: 

The shutter cannot be used in combination with a user-defined rotation (i.e. the function 
“Enter custom angle”). 

 
 
4.2.24.15 Annotations 
 

 

“Annotation”: The annotation tool allows the user to make annotations on images. 
To use this tool, point the mouse at the area that is the cause for the annotation. 
Then drag the mouse towards the area where you wish to place the annotation text. 
Keep the left mouse button pressed while doing so. Longer annotations should start 
farther to the left. When the mouse button is released, an arrow will be displayed 
and the annotation dialog will open. 
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Annotation dialog 

 
Enter the annotation text and click “Accept”. Annotations can only be displayed inside the borders 
of the image. Be sure to use text items that are not too long to exceed the space limit set by 
the image dimensions. The annotation text will be placed next to the end point of the arrow. 
 

 
Example of an annotation 
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NOTICE:  

If no text is entered in the annotation dialog, the arrow will remain anyway. This is 
implemented by design to allow the adding of simple markers (i.e. arrows) that denote specific 

areas in the image without any further information. 
 
 
4.2.24.16 Overlapping of measurement values 
 
In some cases, especially when creating measurements and annotations within small structures, 
measurements may end up very close to each other and the calculated values may overlap. 
Since this makes values difficult to read, iQ-LITE will automatically move the values to avoid an 
overlap. 
 
To insure that each value can still be matched to the measurement where it belongs, a red frame 
is put around any value that was moved and a line connects the value to the corresponding 
measurement. 
 

 
 
 
4.2.24.17 Erasing measurements and annotations 
 

 

“Clear”: The clear tool can be used to erase individual measurements, shutters or 
annotations made in an image. To use this tool, select the “Clear” function, then click 
the measurement, shutter or annotation to be erased. After it turns red, click again 
the item to remove the measurement, shutter or annotation. 

 
Other deleting functions are available in the “Tools” menu: 
 
 “Clear all measurements”: All measurements and annotations (incl. shutters) made in all 

studies loaded into the viewer are removed with one click. 
 “Clear last measurement”: The last object made in an image is removed. 
 

NOTICE: 
All measurements, shutters and annotations made in a series (one view) can be deleted by 
using the “Reset” button or by selecting “Clear presentation states” from the “Tools” menu. 
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However, both tools will reset ALL changes in the active series (e.g. windowing or zoom/pan), 
not only the measurements, shutters and annotations. 

 
 
4.2.24.18 Modifying measurements and annotations 
 

 

“Modify”: The modify tool allows to apply corrections to current measurements and 
annotations. To use this tool, select the measurement, shutter or annotation to be 
modified. The markers displayed on each measurement, shutter or annotation can 
then be used to drag and drop the item into the correct position. 

 
The “Modify” function works as follows:  
 
 Distance measurements: Grab the center marker with the mouse to move the whole line 

into a new position or use the start and end markers of the line to change the length and 
position of the starting and ending points. 

 Ratio measurements: Use the start and end markers of the two lines to change the length 
and position of the starting and ending points. 

 Angle measurements: Grab the center marker to change the position of where the two 
lines cross or use the start and end markers of each line to move the lines into the correct 
position. 

 Cobb’s angle: Use the markers at the end of each line to correct the line positions. The 
perpendicular lines will be adapted automatically by iQ-LITE. 

 Hip dysplasia angle: Grab the center markers of the two femoral head circles to move them 
into a different position. Use the markers in the upper left and lower right corners of each 
circle to adapt the size of the circles. The markers at the end of the two angle rays can be 
used to drag them into the correct position at the craniodorsal rim of the acetabulum. 

 Square and circular ROI: Grab the center marker to move the whole area (rectangular or 
elliptical/circular) or use the line markers to change the size of the area. 

 Shutter: Grab the center marker to move the whole shutter or use the markers in the upper 
left and lower right corners to change the shutter’s size. 

 Annotations: Grab the center marker to move the annotation and arrow to a new location 
or use the marker at the arrow tip to change the length and tip position. The annotation text 
field will open after each move to allow the text to be changed. 

 
 
4.2.24.19 Copying measurements and annotations 
 
This function is only available in iQ-VIEW PRO. 
 

 

“Copy”: Offers the opportunity to copy measurements and annotations already made 
in one image to other images, either of the same series or a different series. This 
function may be particularly helpful in multi-slice studies where a marker made in one 
image of a series could be transferred to other images of the series for better 
visualization, e.g. for spine labeling. 
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4.2.24.20 Calibration of measurements (scaling oversize)  
 
This function is only available in iQ-VIEW and iQ-VIEW PRO. 
 

 

“Calibrate”: The calibrate function calibrates measurements for CR images while 
considering the oversize in the images. 

 
 
4.2.25 Magnifying tools 
 
The regular “magnifier” is the magnifying tool used in iQ-LITE. iQ-VIEW PRO includes an 
additional, special “magnifier window” for magnifying regions of interest in a separate window. 
This function is disabled in iQ-LITE.  
 
 
4.2.25.1 The regular magnifier 
 
The regular magnifier function can be accessed by clicking the “Magnifier” button in the bottom 
toolbar or by selecting “Magnifier” from the “Tools” menu.  
 

 

“Magnifier”: After selecting the magnifying function, the mouse pointer turns into a 
magnifying glass. By holding down the left mouse button while moving over an 
image, the image area is magnified at the position of the mouse. 

 
The magnifying factor can be chosen by using the sub-menu of the menu item or by right-
clicking the “Magnifier” button in the bottom toolbar, which also opens the sub-menu: 
 

 
 
The area over which the magnifier hovers will be magnified according to the chosen preset. The 
default is a magnification at twice the current size.  
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NOTICE: 
Measurements and annotations made in an image will not be visible in the area over which the 

magnifier is used to avoid obstructing the view on regions of interest. 
 
 
4.2.26 Zooming and panning tools 
 
Sometimes individual images or entire series need to be enlarged to improve the visibility of 
diagnostically relevant tissues and structures. Moving images around in their views (panning) 
may also be necessary – for example, to adjust them for easier comparison to another series. 
 
Using the “Scope” function, described in section 4.2.5.4, it is possible to apply zoom and pan 
changes to a whole series or to an individual image only: 
 
 Select “Image scope” to only change the zoom factor or position (pan) of a particular image. 
 Select “Series scope” to apply changes in the zoom factor or position (pan) for one image to 

all images of the same series. 
 

NOTICE: 
Any zoom and pan changes made will be reset when the scope is changed (from series to 

image or from image to series). Zoom/pan can then be applied again according to the newly 
selected scope. 

 
 
4.2.26.1 The zoom/pan function 
 
To zoom (adjust the size) or pan (move) images, either click the “Zoom/Pan” button on the 
bottom toolbar or select “Zoom/Pan” from the “Tools” menu. 
 

 

“Zoom/Pan”: When activated, the zoom/pan function can be used to dynamically 
zoom and pan images using the mouse. The middle area of the image acts as the 
“pan zone”. The mouse pointer turns into a hand icon when pointing there. By clicking 
in the middle of the image and moving the mouse up/down or right/left, the image 
will be moved. The periphery of the image acts as the “zoom zone”. The mouse 
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pointer turns into a magnifier icon when pointing there. By clicking on the periphery 
and moving the mouse up and down, the image can be easily zoomed. 

 
Zooming an image is possible between the zoom factors 0.01 as minimum and 20 as maximum. 
The center of the view is the focus point for the zoom action. 
 
In addition, a sub-menu is available with different zoom presets. The sub-menu is accessed by 
right-clicking the “Zoom/Pan” toolbar button or by right-clicking directly into the image 
processing area (after having selected the zoom/pan function): 
 

 
 
 “Fit in”: This is the default setting. Images are scaled to fit into the available view. The higher 

the tiling, the smaller the images will be displayed. 
 “0.33x”: The images will be zoomed to one third their size. 
 “0.5x”: The images will be zoomed to half their size. 
 “1x (original)”: The images are displayed in their original size. 
 “1.5x”: The images will be zoomed to one and a half times their size. 
 “2x”: The images will be zoomed to two times their size. 
 “2.5x”: The images will be zoomed to two and a half times their size. 
 “3x”: The images will be zoomed to three times their size. 
 

NOTICE: 
“1x (original)” refers to the size of the image only, not the real size of the body structures. 
Potential magnification factors resulting from the image acquisition methods (e.g. in X-ray 

images) are not calculated here.  
 
 
4.2.26.2 The scroll zoom 
 
The “Scroll zoom” function is available in the “Tools” menu. Once the feature is activated, the 
scroll-wheel of the mouse can be used to dynamically zoom the currently active image. 
 
When moving the scroll-wheel of the mouse upwards, the image is enlarged. When moving the 
scroll-wheel of the mouse downwards, the image is made smaller. This behavior is similar to the 
general zoom function. 
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Focus point of the zooming action is the position of the mouse pointer. This means that the area 
under the mouse will remain in the focus while enlarging the image. 
 
 
4.2.27 Flipping and rotation tools 
 
Images loaded into the viewer can be flipped, rotated or both.  
 
Using the “Scope” function, described in section 4.2.5.4, it is possible to apply flip and rotation 
changes to a whole series or to an individual image only: 
 
 Select “Image scope” to flip or rotate only a particular image. 
 Select “Series scope” to apply the flip or rotation changes made in one image to all images 

of the same series. 
 

NOTICE: 
Flipping and rotation will be reset when the scope is changed (from series to image or from 

image to series). The modifications can then be applied again according to the newly selected 
scope. 

 
 
4.2.27.1 The flip/rotate function 
 
The flipping and rotation options are accessible by left-clicking the “Flip/Rotate” button in the 
bottom toolbar or by selecting “Flip/Rotate” in the “Tools” menu. 
 

 
 

 

“Flip/rotate”: Activating the Flip/Rotate function opens a sub-menu containing all 
flipping and rotation options: 
 
 “Flip vertically”: Flips the image vertically.  
 “Flip horizontally”: Flips the image horizontally.  
 “90° rotation clockwise”: Rotates the image in a 90 degree angle to the right. 
 “180° rotation”: Rotates the image in a 180 degree angle. 
 “90° rotation counter-clockwise”: Rotates the image in a 90 degree angle to the 

left. 
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Specific markers are added to the text overlay to indicate whether an image was flipped or 
rotated. * 
 

 
 

*NOTICE: 
To correctly read the markers given in the overlay, it is important to understand that for 

presentation states only horizontal flipping is defined. Therefore, when using vertical flipping 
(as the option is called in iQ-LITE for better understanding), the marker stated in the text 

overlay will include a horizontal flip and a 180° rotation, which is exactly the same as a vertical 
flip. The marker states: “Flipped hor. Rotation: 180°”. 

 
Click “Reset current view” from the sub-menu to reset the flipping and rotation changes. The 
images will return to their original position. Alternatively, the general “Reset” button on the 
bottom toolbar or the menu item “Reset current view” found in the “Tools” menu can be used to 
reset the modifications. Note, however, that the latter options also remove all other modifications 
made to the image(s). 
 
 
4.2.27.2 Using custom rotation 
 
In cases where the rotation presets are not sufficient or the images only need to be adjusted 
slightly, e.g. to turn them upright, a customized rotation can be helpful. iQ-LITE offers the option 
to rotate images in a user-defined way by using the “Enter custom angle” option in the 
“Flip/Rotate” sub-menu. 
 

 

“Flip/Rotate”: To rotate the image to a specific angle, select “Enter custom angle” 
from the sub-menu. A dialog box opens where the desired angle can be entered. 
Either type the angle in the text box or use the up and down arrows to choose the 
correct angle, then click “Accept”. The image (and all images of the same series if 
series scope is chosen) will be rotated accordingly. The image is rotated clockwise. 
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Example of a 45° custom angle 

 
NOTICE: 

It is not possible to use the square and circular ROI measurements tools, the hip dysplasia 
angle or shutters in images that have been rotated to a custom angle. If such 

measurements/annotations were made in an image before it is rotated, they will no longer be 
visible. However, they are not deleted and will be displayed again when the image is rotated 

using a standard rotation setting. 
 
 
4.2.28 Image filters 
 
For the post-processing and quality improvement of images, a number of image filters are 
available in the viewer.  
 
Using the “Scope” function, described in section 4.2.5.4, it is possible to apply image filters 
either to a whole series or to an individual image only: 
 
 Select “Image scope” to apply image filters only to a particular image. 
 Select “Series scope” to apply image filters to all images of the same series. 
 

NOTICE: 
Image filters will be reset when the scope is changed (from series to image or from image to 
series). The modifications can then be applied again according to the newly selected scope. 

 
The available options can be accessed by clicking the “Image filter” button in the bottom toolbar 
or from the “Image filter” menu.  
 

 

“Image filter”:  Upon activation, a sub-menu opens with the following options:  
 
 Sharpen 
 Edge enhance 



 

 

 
PD-730-154 iQ-LITE 3.1 Instructions for Use PUB INT EN – 001R 90 

 

 

 

 

 

 

 
 
 

 

 Noise reduction 
 Blur 
 Low pass 
 High pass 

 
The “Reset” option removes all applied filters and returns the image(s) to their original state. 
 

 
 
 
4.2.29 Resetting changes in images 
 
4.2.29.1 Reset 
 
If modifications made in an image are no longer needed or need to be changed, it is possible to 
reset the changes and start anew. The reset function is available both in the bottom toolbar 
(“Reset” button) and also by selecting “Reset current view” in the “Tools” menu. 
 

 

“Reset”: Selecting the reset function removes all changes made to an image and 
restores the original image (e.g. if the image was windowed, zoomed, rotated). In 
addition, all measurements, annotations and shutters are removed. The reset 
function works on series level. All changes within the same series as the current 
images are removed. Modifications can also be deleted separately. See section 
4.2.24.17 for further information. 

 
 
4.2.29.2 Clear current view 
 
“Clear current view” is used to not only remove changes made in an image, but to empty an 
entire view in the image processing area.  To access this option: 
 
 Click the “Tools” menu 
 Select “Clear current view” 
 The view will be emptied and is left blank. It can then be filled with a new series. 
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4.2.30 Exporting DICOM images to other image formats 
 
DICOM images loaded into the viewer can be exported to other image formats – JPEG, BMP and 
TIFF as well to an AVI video format, for further use, e.g. in a case presentation. iQ-LITE will 
export entire views in which the images are displayed inside the viewer’s image processing area. 
This includes the text overlay (if enabled) as well as any modifications applied to them 
(measurements and annotations, windowing, zoom/pan, flip/rotate, color remap, etc.).  
 

 WARNING: 
Danger of misdiagnosis due to non-diagnostic image material. 

The export of DICOM images to other file formats will result in lossy image quality, which 
means that the images will no longer have diagnostic quality. Therefore, they should not be 

used for diagnostic purposes. 
H.-No.: 1.1.9 

 
Export options are only available as a menu entry.  
 
To export images, click the “File” menu and select “Export image(s)”. A sub-menu offers the 
following possibilities: 
 
 “Current image”: Exports only the currently active image (orange frame). 
 “Whole series”: Exports the entire series to which the current image belongs. 
 “Whole study”: Exports the complete study currently active in the viewer. 
 “All studies loaded”: Exports all studies currently available in the viewer. 
 “Current selection”: Exports a selection of images, series or studies. A selection must be 

made before using this export function. See section 4.2.17 for further details. 
 “Export to AVI”: Allows the exporting of either the current series or a previously made 

selection of images into an AVI video file. 
 

 
 
Exporting images to an AVI file:  
 
“Export as AVI” can be used to export a sequence of images, e.g. an ultrasound series, as a 
video file in the AVI format. Select “Export as AVI” from the sub-menu and the “Save as video 
file” dialog will open. 
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Adjust any settings as necessary: 
 
 Select between “Current series” or “Current selection” for exporting. Current series is the 

default selection. For a selection, the images must first be marked in the viewer (by ticking 
the checkbox in the upper right corner of the view). 

 
NOTICE:  

The images will be converted into AVI in the order in which they were selected in the viewer. 
The output is always the entire view within the selected images reside. 

 
 Set the size of the video frame (X and Y for width and height). When changing one value, 

the other will change accordingly to maintain the proportions of the images.  
 Set the “Interframe delay” in milliseconds. The interframe delay defines the time that passes 

between two frames. The lower the value, the faster the individual frames will be shown. 
 “Force gray-scale (8 bit)” will save the resulting video file as gray-scale. Any color in the 

original images or their mark-ups will be neglected. 
 Select “Compression” if the video file should be compressed. By choosing a compression 

setting, the file will become smaller and more suitable for inclusion in presentations. 
 

NOTICE:  
The available options for compressing AVI files are dependent on the codecs installed on the 

workstation. As a result, the list of compression options may differ from station to station. The 
manufacturer cannot guarantee the correct functioning of the various codecs and, therefore, 
recommends using the Windows default codec “cvid Cinepak Codec.” The use of a corrupted, 
incompletely/incorrectly installed or incompatible codec may lead to undesired effects in iQ-

LITE and/or a faulty video file. 
 

 

After all options have been set, click the “Save as AVI” button to choose the output 
folder, to give the file a name and, eventually, to start exporting the selected data 
as a video file. 
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NOTICE: 
The creation of an AVI file can take a while depending on the number of images selected to be 
converted. A progress bar will indicate when the process will be finished. The dialog will close 

automatically when the AVI file is complete. Do not interact with the program at this time, 
such as clicking the close button (“x”), as this may lead to undesired results. 

 
 
4.2.31 Exporting DICOM images to printers 
 

 

“Print manager”: All images that have been loaded into the viewer, including 
secondary captures already available on the medium, can be sent to the Print 
manager where they can be printed on a connected Windows printer. The images 
will be printed with all of their changes in presentation states (measurements and 
annotations, windowing, zoom/pan, flip/rotate, color remap, etc.). 

 
NOTICE: 

The printing of Structured Reports is not intended. 
 
For more information about printing DICOM images on paper printers, read section 4.30.  
 
The print manager can be accessed in one of the following ways: 
 
 Click the “File” menu and select “Print manager.” The entire study currently active in the 

viewer is transferred. Alternatively, specific images can be selected in the viewer to be 
transferred. 

 Click the “Print manager” button available in the bottom tool bar to transfer the current study 
or a selection to the print manager. 

 Use the default shortcut [P] for accessing the print manager window. 
 

NOTICE: 
For instructions on how to select images, series and studies in the viewer, see section 4.2.17. 

 
 
4.2.32 DICOM header information 
 
The DICOM header of an image shows all DICOM related information about the current image in 
the image processing area (orange frame), such as patient information, study, series and image 
information. Additional information includes meta-tags and other values defining the structure 
and display of the image.  
 
The DICOM header can be accessed by selecting “DICOM header dump” in the “Tools” menu or 
by using the default shortcut [H] in the viewer.  
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Three different tables are available in the “DICOM header viewer”: the “List view”, the “Tree 
view” and the “Summary”. 
 
 
4.2.32.1 “List view”  
 
The “List view” gives an overview of all available DICOM attributes and their values of one 
particular DICOM object, which can be an image or a structured report.  
 

 
List view in DICOM header dump 
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4.2.32.2 “Tree view”  
 
The “Tree view” table gives a more structured overview of the DICOM tags and values of an 
object. The tags are collected into their respective attribute groups. Groups can then be opened 
to reveal the individual tags and their values as well as additional details concerning each. If not 
needed, the individual parts of the tree can be closed again. By default, the various levels are 
closed.  
 

 
Tree view in DICOM header dump 

 
 Click the “+” to open a level with its underlying sections and display all corresponding 

attributes with their respective values. The respective group must first be selected. 
 

 Click the “–” to close an open level. The respective group must first be selected. 
 
In addition, the DICOM header data, as displayed in the “Tree view”, can be saved as an XML 
file to a directory of your choice (“Save as XML”). This file may then also be printed with the 
print functions provided by Windows printers. It could be used in cases of trouble-shooting, 
where a look into the DICOM information may help identify display issues or such. 
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4.2.32.3 “Summary”  
 
In the “Summary” table, it is possible to select an assortment of DICOM tags (up to six) whose 
values can be available at a glance. All tags are given in the drop-down lists. 
 
The summary can be used to display items with longer values, for which the space in the text 
overlay within the image processing area is not sufficient. Instead of filling too much area of a 
view with overlay text information, this summary allows enough space to show certain tags, 
such as “Study comments”. The number of labels in the text overlay is also limited. This summary 
provides the option to easily get further information. Another use would be to view private tags 
or Worklist procedure tags. In either case, the “Summary” view offers a simple solution. 
 

NOTICE: 
Since settings cannot be stored permanently on a medium, any settings changed from the 

default will not be remembered for the next start of the application. 
 

 
Example of DICOM tag selection in “Summary” view of DICOM header dump 
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4.2.33 Help options 
 
The help options are found under the “Help” menu: 
 

 
 
 “Instructions for use”: Opens the iQ-LITE instructions for use, i.e. the user manual.  
 

NOTICE:  
Acrobat Reader or another PDF reader must be installed/available on the system to open and 

view the iQ-LITE instructions for use, which is included as a PDF file on the medium 
(MANUAL.PDF). 

 
 “About”: Opens a window where version information about the iQ-LITE software as well as 

contact information for questions or bug reports is displayed. Clicking the window opens a 
support email form that can be used to contact a local reseller for bug reports, technical 
advice, etc.  

 
NOTICE:  

A standard email client (Outlook, Outlook Express, etc.) must be installed and configured to 
automatically open an email form. 
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4.3 Windows print  
 
4.3.1 The print manager  
 
With iQ-LITE, DICOM image data can be printed using a Windows printer. To output individual 
images, series or studies, the studies must first be loaded into the viewer.  
 

NOTICE: 
The print manager is only intended for the printing of DICOM images, but not for the printing 
of reports (e.g. SR or DICOM PDF). The attempt to print structured report objects may lead to 
incomplete print-outs, which may then result in missing diagnostic information for the recipient 
of the report. DICOM PDF objects are not supported at all and should instead be printed using 

the PDF reader options in the iQ-LITE viewer window. 
 
Once loaded, the print manager can be accessed by selecting “Print manager” from the “File” 
menu of the viewer. The print manager window can also be accessed using the default shortcut 
[P] or by using the “Print manager” button in the bottom toolbar. All methods lead to the print 
manager opening and transferring the selected images into the preview: 
 

 
Print manager 

 
Changes made in images during their processing in the viewer are transferred into the print 
manager as well. This allows the images to be printed with their modifications, e.g. added 
measurements and annotations, window level changes, flipping/rotation, zoom/pan. 
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4.3.2 Printer, paper format and orientation selection  
 
The printer, paper format and orientation must be selected from the drop-down menus in the 
upper part of the print manager screen before printing: 
 
 “Printer/film imager”: Select the appropriate Windows printer for printing the images. Any 

local or networked Windows printer can be chosen.  
 

NOTICE:  
In general, printouts of DICOM images, particularly paper printouts, may not be of a diagnostic 

quality and should, therefore, not be used to provide diagnostic findings.  
For higher quality printouts, the use of PostScript printers is recommended. 

 

 

Clicking the “Printer/film imager settings” button after selecting a specific printer 
brings up the typical Windows printer properties to change settings for the printer. 

 
 “Paper/film format”: This option is only available for DICOM print. As DICOM print is not 

available in iQ-LITE, this option is grayed-out.  
 
 “Orientation”: Choose between portrait or landscape orientation for printing. The print mana-

ger preview is changed accordingly. 
 
 
4.3.3 Image output and layout selection  
 
On the right side of the print manager screen, several options are available regarding the output 
and layout: 
 
 “Image output”: Here, you can select what to print. The following options are available: 

- Current image: The one in the active view of the viewer window (orange frame). 
- Current series: The series in the active view of the viewer window. 
- Current study: The active study.  
- Selection: A selection made previously in the viewer by marking images. With this option, 

it is possible to print several complete studies or parts of different studies. See section 
4.2.17 for more information on how to make selections. 

 
 “Layout”: The layout determines how many images will print on a single page. The desired 

layout can be selected from the drop-down box: 
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iQ-LITE already provides a number of layouts to choose from. It is also possible to type a 
new layout into the “Layout” field. 

 

 
 

The print preview will be adjusted accordingly. The rows and columns number is limited to 
“7” (49 images per page maximum).  

 
The “+” and “–” buttons are grayed out in iQ-LITE. They are normally used to add new layouts 
or delete existing layouts and store this for later use. As it is not possible to store information 
on a medium, these options are not available.  

 
 “Page controller”: The page controller gives information about how many pages will be 

needed for printing the selected images. If more than one page will print, the slider bar can 
be used to navigate between viewing the different pages. Drag the slider to the desired page 
or click in the page controller bar to the left or right of the indicator to move one page at a 
time in the respective direction.  

 
NOTICE: 

Alternatively, you can also place the mouse over the print preview and use the scroll-button to 
browse through the prepared pages. 

 
 “Print text overlay”: The text overlay for the images will be printed if checked.  
 
 “Print page header”: The page headers with the patient information will be printed if checked.  
 

NOTICE:  
If images from more than one study/patient are selected for print, the page header will only 

print the details of the first study. To avoid confusion, be sure to keep the “Print text overlay” 
activated and deactivate the “Print page header.” 
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 “Text background”: Activating this option will put a black bar behind all elements of the text 
overlay so that the white text overlay will always be readable, even if the images are very 
bright. 

 
 “Reduce print job size”: In the standard Windows print mode, print jobs from iQ-LITE can 

sometimes become very large (up 100 MB). This may lead to longer transmission times to a 
Windows printer or buffer overflow errors if the printer does not have enough memory. 
Checking the “Reduce print job size” may prevent these issues by transmitting less data to 
the printer.  

 
NOTICE:  

A reduction of the print job size is achieved by reducing the resolution and may lead to lower 
quality printouts on some printers. 

 
 “Real-size print”: Using the “Real-size print” option, it is possible to print images on a DICOM 

printer in real size (1:1 print). This function is only available in iQ-VIEW/PRO. 
 
 
4.3.4 Editing images for printing  
 
The editing of images in the print manager can be done on the image or series level (except for 
drag/drop and the deletion of images). The selection is made using the “Scope” buttons at the 
top of the screen: 
 

 

“Image scope”: Select scope on the image level if modification (window or zoom/pan) 
should only happen to a single image. 

 

 

“Series scope”: Select scope on the series level if the entire series should be modified 
(window or zoom/pan). 

 
Various tools can be used to edit the images shown in the preview windows. The active tool is 
displayed with an orange frame. 
 

 

“Zoom/Pan”: An image can be moved by pointing to the middle of it (pan zone) and 
pressing the left mouse button while moving the mouse. The mouse pointer turns 
into a hand when pointing to the middle of the image. To enlarge the image, point 
to the periphery of the image (zoom zone) and hold the left mouse button down 
while moving the mouse up (to enlarge) and down (to minimize). The mouse pointer 
becomes a magnifier symbol when pointing to the edge of the image. The zoom/pan 
will affect only the selected image or the entire series, depending on the scope 
selected (image or series). 

 

 

“Windowing”: The brightness and contrast of an image can be manually adjusted by 
pressing the left mouse button and moving the mouse up/down or left/right while 
hovering over the image. The mouse pointer turns into the windowing icon when the 
tool is activated. Window changes will affect only the selected image or the entire 
series, depending on the scope selected (image or series). 
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“Drag/Drop”: With drag/drop, images can be moved into another position (tile) if a 
layout is chosen that contains more than one image per page. Note, however, that 
images can only be moved within the filled tiles. For example, in a 3x3 tiling with 
only 6 tiles filled, images can only be switched in the first 6 tiles. The last 3 tiles 
cannot be used.   
 
To move an image, point to it and hold the left mouse button down while dragging 
the image to the new tile. When the mouse button is released, the image will move 
into the new location and all other images on the page will slide into a new position, 
to fill the empty space of the moved image and to make room for the moved image. 
The general order of the other images will be maintained; only the moved image will 
be out of that original order. 
 Example 1: Original image order = 1 – 2 – 3 – 4  image 4 is moved into view 

with image 1  new image order = 4 – 1 – 2 – 3 
 Example 2: Original image order = 1 – 2 – 3 – 4  image 1 is moved into view 

with image 3  new image order = 2 – 3 – 1 – 4  
 

 Example 1:        Example 2: 

         
 

 

“Delete”: The delete function removes either single images or entire series, 
independently of the set scope (image or series). Upon activation, the mouse pointer 
will change into the delete icon when hovering over an image. The following options 
are available: 
 
 No deletion is possible if “Image output” is set to “Current image”. 
 If “Image output” is set to “Current series”, only individual images can be deleted, 

not the whole series. 
 If “Image output” is set to “Current study”, the option to “Remove individual 

images” or to “Remove entire series” appears when the tool is selected. 
 If “Image output” is set to “Selection”, the entire selection of images is treated 

as if they are from one series. The two options, “Remove individual images” and 
“Remove entire series” will appear when the tool is selected.  However, “Remove 
entire series” will remove all but the first image from the preview since at least 
one image must remain in the print manager. 

 
Once the delete tool is activated, click the individual image or one that is part of the 
series to be deleted. This only removes the image(s) from the print manager and 
does not affect what is displayed in the viewer. 

 
NOTICE:  

One image must always remain in the preview to avoid blank printed pages. 
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4.3.5 Starting a print job 
 

 

After selecting the various print options discussed above, click the “Print” button to 
send the print job to the selected Windows printer. 
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5 Abbreviations and acronyms 
 

Abbreviation Meaning 

AVI Audio Video Interlaced 

B/w Black/white 

BMP Bitmap 

CD Compact Disk 

CPU Central Processor Unit 

CR Computed Radiography 

CT Computed Tomography 

DICOM Digital Imaging and Communication in Medicine 

DVD Digital Versatile Disk 

EEA European Economic Area 

EEC European Economic Community 

FDA Food and Drug Administration 

Fps Frames per second 

GB Gigabyte 

H.-No. Hazard Number (in risk management) 

HDD Hard Disk Drive 

HU Hounsfield Unit 

ID Identifier 

ISO International Standard Organization 

IT Information Technology 

JPEG Joint Photographic Expert Group 

MB Megabyte 

MD Medical Doctor 

MR or MRI Magnetic Resonance Imaging 

NUC Nuclear Medicine 

PACS Picture Archiving and Communication System 

PC Personal Computer 

PDF Portable Document Format 

PR Presentation State (object) 

PUB Public 

Pxl Pixel 

RAM Random Access Memory 

RF Radiographic Fluoroscopy 

ROI Region of Interest 
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Abbreviation Meaning 

SOP Service Object Pair 

TIFF Tagged Image File Format 

US Ultrasound  

W/C Window/Center 

XML Extensible Markup Language 
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6 List of shortcuts 
 
Available shortcuts for the iQ-LITE study browser are:  
 

Shortcut Function 

[SHIFT] When used in combination with a mouse-click on studies in 
the study table, will mark all studies between the first- and 
second-selected 

[CTRL] When used in combination with a mouse-click on studies in 
the study table, will multi-select all clicked studies  

 
Available shortcuts for the iQ-LITE viewer are:  
 

Shortcut Function 

Navigation options 

Arrow key [DOWN] Navigates to the next image in the active series 

Arrow key [UP] Navigates to the previous image in the active series 

[END] Navigates to the last image in the active series 

[HOME] Navigates to the first image in the active series 

Arrow key [RIGHT] Switches to the next series of the study 

Arrow key [LEFT] Switches to the previous series of the study 

Viewer functions and actions 

[CTRL] When used in combination with a mouse-click in un-activated 
views with different series, will mark the views to be included 
in series synchronization 

[H] Opens the “DICOM header dump” 

[L] Activates and deactivates the “Lightbox window” 

[P] Opens the “Print manager” with the active/selected data 

[S] Selects/unselects the current image (e.g. for image export or 
transfer to the print manager) 

[CTRL]+[S] Selects/unselects a whole study (e.g. for image export or 
transfer to the print manager) 
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7 Index 
 

A 

Annotation tool .............................. 71, 80 
Annotation tool (copying annotations) .....83 
Annotation tool (erasing annotations) .....82 
Annotation tool (modifying annotations) ..83 
Antivirus software.................................20 
Automatic loading of images ..................37 
Automatic tiling of studies .....................37 

B 

Bind series function ..............................40 
Bitmap overlays (display of) ..................63 
Bottom toolbar .....................................37 
Bottom toolbar (default) ........................38 
Bottom toolbar (fixing of) ......................37 
Bringing study browser to front ..............47 

C 

Caching data on hard disk .....................30 
Calibration of measurements .................84 
Cine mode ...........................................65 
Cine mode (cine control) .......................67 
Cine mode (pausing autoplay) ................66 
Cine mode (playing of series) .................66 
Cine mode (setting direction) .................67 
Cine mode (setting frame rate) ..............67 
Cine mode (stack) ................................66 
Cine mode (starting autoplay) ................66 
Cine mode (stopping autoplay)...............66 
Closing the viewer ................................47 
Color remapping ...................................71 
Color remapping (grayscale output) ........71 
Color remapping (inverted grayscale 

output) .............................................71 
Color remapping (inverted) ....................71 
Color remapping (nuclear color schemes) 71 
Color schemes .....................................71 
Color schemes (nuclear medicine) ..........71 
Comparison of studies ...........................53 
Configuration .......................................24 
Context menus (right-click mouse) .........44 
Custom rotation ...................................88 

D 

DICOM header dump ............................93 

DICOM header information ................... 93 
DICOM header information (list view) ..... 94 
DICOM header information (saving to XML)

 ...................................................... 95 
DICOM header information (summary) ... 96 
DICOM header information (tree view) ... 95 
DICOM PDF (system requirements) ........ 20 
DICOMDIR (iQ-LITE database) .............. 26 
Display settings ................................... 48 
Display settings (dual display setup) ...... 48 

E 

Evaluating iQ-VIEW/PRO ...................... 23 
Exporting DICOM images to AVI ............ 91 
Exporting DICOM images to AVI (making 

settings) .......................................... 91 
Exporting DICOM images to image formats

 ...................................................... 91 
Exporting DICOM images to JPEG, BMP, 

TIFF ................................................ 91 
Exporting DICOM images to video files ... 91 

F 

Flipping images ................................... 87 
Flipping options ................................... 87 

H 

Hardware requirements ........................ 18 
Help options ....................................... 97 

I 

Image filter blur .................................. 90 
Image filter edge enhance .................... 89 
Image filter high pass .......................... 90 
Image filter low pass ............................ 90 
Image filter noise reduction .................. 90 
Image filter sharpen ............................ 89 
Image filters ....................................... 89 
Image filters (resetting of).................... 90 
Image preview (study browser) ............. 28 
Image processing area ......................... 34 
Installation of iQ-LITE .......................... 23 
Installing the software ......................... 23 
Instructions for use .............................. 97 
Instructions for use (access from study 

browser) .......................................... 26 
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Instructions for use (access from viewer) 97 
iQ-LITE database (DICOMDIR) ...............26 

L 

Licensing of iQ-LITE ..............................23 
Licensing the software ..........................23 
Lightbox window ..................................49 
Lines function ................................ 41, 57 
Lines function (scoutpilot function) .........41 
Loading studies/series into viewer ..........29 
Look-up tables (support of) ...................61 
Look-up tables (use of) .........................64 

M 

Magnifier .............................................84 
Magnifying tools ...................................84 
Magnifying tools (regular magnifier) .......84 
Maintenance (display calibration) ...........21 
Maintenance (ensuring hard disk space) ..21 
Maintenance (protection from 

virus/malware infection) .....................21 
Maintenance tasks ................................21 
Measurement tools ...............................71 
Measurement tools (angles) ...................77 
Measurement tools (calibrated vs. at 

detector) ..........................................73 
Measurement tools (calibration of 

measurements) .................................84 
Measurement tools (circular ROI) ...........79 
Measurement tools (clearing of all 

measurements) .................................82 
Measurement tools (clearing of last 

measurement) ..................................82 
Measurement tools (Cobb’s angles) ........77 
Measurement tools (copying 

measurements) .................................83 
Measurement tools (distance 

measurements in ultrasound) ..............74 
Measurement tools (distances) ...............76 
Measurement tools (erasing 

measurements) .................................82 
Measurement tools (hip dysplasia angle) .78 
Measurement tools (interior angle) .........78 
Measurement tools (modifying 

measurements) .................................83 
Measurement tools (overlapping values) .82 
Measurement tools (perpendicular distance)

 .......................................................77 

Measurement tools (PixelSpacing vs 
ImagerPixelSpacing) ......................... 73 

Measurement tools (point-to-line distance)
 ...................................................... 77 

Measurement tools (polygonal ROI) ....... 80 
Measurement tools (ratios) ................... 76 
Measurement tools (shutters) ............... 80 
Measurement tools (square ROI) ........... 79 
Menu bar ............................................ 43 
Menu bar (Additional settings section) .... 43 
Menu bar (File section) ......................... 43 
Menu bar (Help section) ....................... 43 
Menu bar (Image filter section) ............. 43 
Menu bar (Image selection section) ....... 43 
Menu bar (Navigation section) ............... 43 
Menu bar (Tools section) ...................... 43 
Mouse actions ..................................... 43 
Mouse cursors (for viewer actions) ........ 45 
Mouse cursors (size options) ................. 45 
Multi-frame objects (treatment of) ......... 51 

N 

Navigating the study table .................... 28 
Navigation options (viewer) .................. 52 
Navigation options (within a series) ....... 52 
Navigation options (within a study) ........ 53 
Navigation options (within several studies)

 ...................................................... 53 

O 

Orientation indicators ........................... 35 
Orientation tools .................................. 57 
Orientation tools (lines mode) ............... 57 
Orientation tools (scoutlines configuration)

 ...................................................... 58 
Orientation tools (scoutpilot) ................. 57 
Overlays (support of) ........................... 61 

P 

Pan options ......................................... 85 
Pan zone ............................................ 85 
Panning images ................................... 85 
Potential patient mix warning ................ 62 
Presentation states (clearing of) ............ 60 
Presentation states (description) ........... 59 
Presentation states (support of) ............ 60 
Preview icons panel (in study browser) ... 29 
Print manager ..................................... 98 
Print manager (deleting images) .......... 102 
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Print manager (drag/drop) ................... 102 
Print manager (editing images for printing)

 ..................................................... 101 
Print manager (image output selection) ...99 
Print manager (layout selection) .............99 
Print manager (page controller) ........... 100 
Print manager (paper format selection) ...99 
Print manager (print orientation selection)

 .......................................................99 
Print manager (printer selection) ............99 
Print manager (printing 

images/series/studies) .......................98 
Print manager (printing page header) ... 100 
Print manager (printing text background)

 ..................................................... 101 
Print manager (printing text overlay) .... 100 
Print manager (real-size print) ............. 101 
Print manager (starting a print job) ...... 103 
Print manager (windowing) .................. 101 
Print manager (zooming/panning images)

 ..................................................... 101 
Printing DICOM images .........................93 
Printing DICOM images (Windows print) ..93 
Purchasing iQ-VIEW/PRO .......................23 

R 

Rescanning the medium (study browser) .26 
Reset function (clear current view) .........90 
Reset function (reset button) .................90 
Reset function (reset current view) .........90 
Resetting changes in images ..................90 
Rotating images ...................................87 
Rotation options ...................................87 
Rotation options (using custom rotation) .88 
Ruler (pixel-spacing) .............................35 
Ruler display ........................................35 

S 

Scaling oversize (for distance 
measurements) .................................84 

Scope function .....................................40 
Scope on image level (viewer) ...............40 
Scope on series level (viewer) ................40 
Scoutlines (configuration of) ..................58 
Scoutpilot ...................................... 41, 57 
Screen tiling (on image level) ................36 
Screen tiling (on series level) .................36 
Screen tiling options .............................35 
Scroll zoom..........................................86 

Selecting studies/series (study table) ..... 28 
Selection of images .............................. 56 
Selection of images (clearing of) ........... 57 
Selection of images (marking of images . 56 
Selection of images (within a series) ...... 56 
Selection of images (within a study) ...... 56 
Selection of series (for viewing) ............ 53 
Series preview bar ............................... 31 
Series preview bar (functions of) ........... 32 
Series preview bar (information in) ........ 32 
Series preview bar (size of) .................. 33 
Series selection (for viewing) ................ 53 
Shutter function .................................. 80 
Shutters (embedded) ........................... 64 
Side toolbar ........................................ 38 
Side toolbar (Bind series) ..................... 40 
Side toolbar (fixing of) ......................... 38 
Side toolbar (Lines) ............................. 41 
Side toolbar (Off) ................................ 43 
Side toolbar (Scope) ............................ 40 
Side toolbar (Sync) .............................. 39 
Single-frame images (treatment of) ....... 51 
Software configuration ......................... 24 
Software maintenance.......................... 21 
Sorting in study table ........................... 28 
Stack mode ........................................ 65 
Stack mode (browsing through series) ... 65 
Starting iQ-LITE automatically ............... 23 
Starting iQ-LITE manually ..................... 23 
Storage format for media ..................... 19 
Study browser (access to instructions for 

use) ................................................ 26 
Study browser (preview icons panel) ...... 29 
Study browser (rescanning medium) ...... 26 
Study browser (study table).................. 26 
Study browser window ......................... 25 
Study table (in study browser) ......... 26, 29 
Study table (loading studies/series into 

viewer) ............................................ 29 
Study table (navigation) ....................... 28 
Study table (selecting studies/series) ..... 28 
Study table (sorting) ............................ 28 
Study table (study information) ............. 27 
Study tabs .......................................... 33 
Support information ............................. 97 
Support information (access to) ............ 97 
Sync function ...................................... 39 
Synchronizing different series ............... 39 
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System requirements ............................18 
System requirements (DICOM PFD) ........20 
System requirements (DICOM storage 

format) ............................................19 
System requirements (ensuring system 

security) ...........................................20 
System requirements (specific for Unicode 

languages) ........................................19 
System requirements (web browsers) .....19 

T 

Text overlay ........................................61 
Text overlay (activation of) ....................61 
Text overlay (deactivation of) ................61 
Text overlay (display of lossy image 

compression) ....................................62 

U 

Uninstalling iQ-LITE ..............................23 

V 

View (accessing viewer) ........................30 

View button ........................................ 30 
Viewer ............................................... 30 
Viewer window .................................... 31 
Visual style ......................................... 25 

W 

Windowing (applying window changes) .. 67 
Windowing (auto-contrast) ................... 70 
Windowing (dynamic) .......................... 68 
Windowing (ROI window) ..................... 69 
Windowing (static) ............................... 67 
Windowing (using window presets) ........ 68 
Windowing tools .................................. 67 
Windows print ..................................... 98 
Windows print (reducing print job size) . 101 

Z 

Zoom options ...................................... 85 
Zoom options (scroll zoom) .................. 86 
Zoom zone ......................................... 85 
Zooming images .................................. 85 
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